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Safety messages

NOTICE
Read this manual before working with the product. For personal and system safety, and for optimum product
performance, make sure you thoroughly understand the contents before installing, using, or maintaining this
product.
For technical assistance, contacts are listed below:

Customer Central
Technical support, quoting, and order-related questions.
• United States - 1-800-999-9307 (7:00 am to 7:00 pm CST)
• Asia Pacific- 65 777 8211
North American Response Center
Equipment service needs.
• 1-800-654-7768 (24 hours a day — includes Canada)
• Outside of these areas, contact your local Emerson representative.

 WARNING
Failure to follow safe installation and servicing guidelines could result in death or serious injury.
Ensure only qualified personnel perform installation or service.
Use the equipment only as specified in this manual. Failure to do so may impair the protection provided by the
equipment.
Flamepath joints are not for repair. Contact the manufacturer.

 WARNING
Explosions could result in death or serious injury.
Verify that the operating environment of the transmitter is consistent with the appropriate hazardous locations
specifications.
Temperature restrictions apply for Explosion-proof versions. For limits, see certificate-specific information in the
Rosemount 3300 Product Certifications document.
In an explosion-proof/flameproof installation, do not remove the transmitter covers when power is applied to the
unit.
Eliminate the risk of Electrostatic Discharge (ESD) discharge prior to dismounting the transmitter head. Probes may
generate an ignition-capable level of electrostatic charge under extreme conditions. During any type of installation or
maintenance in a potentially explosive atmosphere, the responsible person should ensure that any ESD risks are
eliminated before attempting to separate the probe from the transmitter head.
Before connecting a handheld communicator in an explosive atmosphere, ensure that the instruments are installed in
accordance with intrinsically safe or non-incendive field wiring practices.

 WARNING
Electrical shock could cause death or serious injury.
Avoid contact with the leads and terminals. High voltage that may be present on leads can cause electrical shock.
Ensure the mains power to the transmitter is off and the lines to any other external power source are disconnected or
not powered while wiring the transmitter.
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 WARNING
Process leaks could result in death or serious injury.
Ensure that the transmitter is handled carefully. If the process seal is damaged, gas might escape from the tank.
To avoid process leaks, only use the O-ring designed to seal with the corresponding flange adapter.

 WARNING
Any substitution of non-authorized parts or repair, other than exchanging the complete transmitter head or
probe assembly, may jeopardize safety and is prohibited.
Unauthorized changes to the product are strictly prohibited as they may unintentionally and unpredictably alter
performance and jeopardize safety. Unauthorized changes that interfere with the integrity of the welds or flanges,
such as making additional perforations, compromise product integrity and safety. Equipment ratings and
certifications are no longer valid on any products that have been damaged or modified without the prior written
permission of Emerson. Any continued use of product that has been damaged or modified without the written
authorization is at the customer’s sole risk and expense.

 WARNING
Physical access
Unauthorized personnel may potentially cause significant damage to and/or misconfiguration of end users’
equipment. This could be intentional or unintentional and needs to be protected against.
Physical security is an important part of any security program and fundamental in protecting your system. Restrict
physical access by unauthorized personnel to protect end users’ assets. This is true for all systems used within the
facility.

NOTICE
The products described in this document are NOT designed for nuclear-qualified applications. Using non-nuclear
qualified products in applications that require nuclear-qualified hardware or products may cause inaccurate readings.
For information on Rosemount nuclear-qualified products, contact your local Emerson Sales Representative.

 CAUTION
This product is designed to meet FCC and R&TTE requirements for a non-intentional radiator. It does not require any
licensing whatsoever and has no tank restrictions associated with telecommunications issues.

 CAUTION
This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions:
This device may not cause harmful interference.
This device must accept any interference received, including interference that may cause undesired operation.
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1  Introduction
1.1  Using this manual

This manual provides installation, configuration and maintenance information for the
Rosemount™ 3300 Level Transmitter.
Transmitter overview contains an introduction to theory of operation a and description of
the transmitter. Information on applications, process and vessel characteristic, and a probe
selection guide are also included.
Mechanical installation contains mounting considerations and mechanical installation
instructions.
Electrical installation contains electrical installation instructions.
Configuration provides instructions on configuration of the transmitter using the Radar
Configuration Tool (RCT) software or a handheld communicator.
Operation contains operation techniques such as viewing measurement data and display
functionality.
Service and troubleshooting provides troubleshooting techniques for the most common
operating problems, as well as diagnostic and error messages, and service instructions.
Specifications and reference data supplies reference and specification data.
Configuration parameters provides extended information about the configuration
parameters.
HART® to Modbus® Converter (HMC) module describes the operation of the HART® to
Modbus® Converter (HMC).

1.2  Product certifications
See the Rosemount 3300 Product Certifications document for detailed information on the
existing approvals and certifications.

1.3  Product recycling/disposal
Consider recycling equipment and packaging. Dispose of the product and packaging in
accordance with local and national legislation.
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2  Transmitter overview

2.1  Measurement principle
Low power, nano-second microwave pulses are guided down a probe submerged in the
process media. When a microwave pulse reaches a medium with a different dielectric
constant, part of the energy is reflected back to the transmitter.
The transmitter uses the residual wave of the first reflection for measuring the interface
level. Part of the wave, which was not reflected at the upper product surface, continues
until it is reflected at the lower product surface. The speed of this wave depends fully on
the dielectric constant of the upper product.
The time difference between the transmitted and the reflected pulse is converted into a
distance, and the total level or interface level is then calculated. The reflection intensity
depends on the dielectric constant of the product: the higher dielectric constant value, the
stronger reflection.

Figure 2-1: Measurement Principle

B

C

A

A. Reference pulse
B. Level
C. Interface level

2.2  Application examples
The Rosemount 3300 Level Transmitter is suited for aggregate (total) level measurements
on most liquids, semi-liquids, and liquid/liquid interfaces.
Guided microwave technology offers the highest reliability and precision to ensure
measurements are virtually unaffected by temperature, pressure, vapor gas mixtures,
density, turbulence, bubbling/boiling, low level, varying dielectric media, pH, and viscosity.
Guided wave radar technology in combination with advanced signal processing makes the
Rosemount 3300 Level Transmitters suitable for a wide range of applications:
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Boiling conditions with vapor and turbulence
The Rosemount 3300 Level Transmitter works well in boiling conditions with vapor and
turbulence. If there are disturbing objects in the vicinity of the transmitter, the coaxial
probe is particularly suitable.

Separators, accumulators, and production tanks
The Rosemount 3302 measures both level and interface level in a separator tank.

3301

Oil

Oil
Water

3302
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Chamber applications
The Rosemount 3300 Level Transmitter is well suited for chamber applications, such as
distillation columns.

Waste tanks and sump pits
The Rosemount 3300 Level Transmitter is a good choice for underground tanks. It is
installed on the top of the tank with the radar pulse concentrated near the probe. It can be
equipped with probes that are unaffected by high and narrow openings or nearby objects.
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Small ammonia, NGL, and LPG tanks
Guided wave radar technology is a good choice for reliable measurements in small
ammonia, NGL, and LPG tanks.

2.3  System architecture
The Rosemount 3300 Level Transmitter is loop-powered which means it uses the same
two wires for both power supply and output signal. The output is a 4-20 mA analog signal
superimposed with a digital HART® signal.
By using the optional Rosemount 333 HART Tri-Loop™, it is possible to convert the HART
signal to up to three additional 4-20 mA analog signals.
With the HART protocol it is possible to use multidrop configuration. In this case
communication is restricted to digital since current is fixed to the 4 mA minimum value.
The transmitter can be connected to display Rosemount 751 Field Signal Indicator or it can
be equipped with an integral display.
The transmitter can easily be configured by using a handheld communicator or a PC with
the Radar Configuration Tool (RCT) software. The Rosemount 3300 is also compatible with
AMS Device Manager, which can also be used for configuration.
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Figure 2-2: System Architecture
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A. Integral display
B. Rosemount 3300 Level Transmitter
C. Rosemount 751 Field Signal Indicator
D. 4-20 mA/HART
E. Handheld communicator
F. Tri-Loop
G. 3 x 4-20 mA
H. HART modem
I. RCT or AMS Device Manager
J. DCS

2.4  Components of the transmitter
The Rosemount 3300 Level Transmitter has an aluminum or stainless steel transmitter
housing which contains advanced electronics for signal processing. The radar electronics
produces an electromagnetic pulse, which is guided by the probe.
There are different probe types available for various applications: rigid twin lead, flexible
twin lead, rigid single lead, segmented rigid single lead, flexible single lead, and coaxial.
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Figure 2-3: Transmitter Components

A. Cable entry: ½-in. NPT; Optional adapters: M20, eurofast®, minifast®

B. Radar electronics
C. Flanged process connections
D. Probe
E. Dual compartment housing
F. Threaded process connections
G. BSPP (G)
H. NPT
I. Flexible single lead with weight
J. Rigid single lead

K. Flexible twin lead with weight
L. Rigid twin lead

M. Coaxial
N. Segmented rigid single lead probe

2.5  Process characteristics
The Rosemount 3300 Level Transmitter has high sensitivity because of its advanced
signal processing and high signal-to-noise ratio. This makes it able to handle various
disturbances, however, the following circumstances should be considered before
mounting the transmitter.
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2.5.1  Contamination/product build-up
Heavy contamination or product build-up on the probe should be avoided since it may
decrease the sensitivity of the transmitter and lead to measurement errors.
For viscous or sticky applications, it is important to choose a suitable probe. Periodic
cleaning may also be required.
Maximum measurement error due to contamination is 1-10 percent depending on probe
type, dielectric constant, contamination thickness and contamination height above product
surface.
Related information
Contamination/product build-up

2.5.2  Bridging
Heavy product build-up results in bridging between the two probes in a twin lead version,
or between the pipe and inner rod for coaxial probes, and may cause erroneous level
readings, so it must be prevented. A single lead probe is recommended in these situations.

2.5.3  Foam
The Rosemount 3300 Level Transmitter measurement in foamy applications depends on
the foam properties; light and airy or dense and heavy, high or low dielectrics, etc. If the
foam is conductive and creamy, the transmitter may measure the surface of the foam. If
the foam is less conductive, the microwaves may penetrate the foam and measure the
liquid surface.

2.5.4  Vapor
In some applications, such as high pressure boiling water, there is a heavy vapor above the
product surface that could influence the level measurement. The Rosemount 3300 Level
Transmitter can be configured to compensate for the influence of vapor.

2.5.5  Interface measurements
The Rosemount 3302 is a good choice for measuring the interface of oil and water, or other
liquids with significant dielectric differences. It is also possible to measure interfaces with a
Rosemount 3301 in applications where the probe is fully submerged in the liquid.
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Figure 2-4: Interface Level Measurement
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A. Rosemount 3302
B. Rosemount 3301 (fully submerged)
C. Product level
D. Interface level

2.6  Vessel characteristics
2.6.1  Heating coils, agitators

Because the radar signal is transmitted along a probe, the transmitter is generally not
affected by objects in the tank. Avoid physical contact with metallic objects when twin lead
or single lead probes are used.
Avoid physical contact between probes and agitators, as well as applications with strong
fluid movement, unless the probe is anchored. If the probe is able to move 1 ft. (30
cm) from any object, such as an agitator, during operation, the probe tie-down is
recommended.
To stabilize the probe for side forces, a weight may be hung at the probe end (flexible
probes only) or fix/guide the probe to the tank bottom.

2.6.2  Tank shape
The guided wave radar transmitter is insensitive to the tank shape. Since the radar signal
travels along a probe, the shape of the tank bottom has no effect on the measurement
performance. The transmitter handles flat or dish-bottom tanks equally well.
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2.7  Probe selection guide
Use the following guidelines to choose appropriate probe for your Rosemount 3300 Level
transmitter:

Table 2-1: Probe Selection Guide
G=Good, NR=Not Recommended, AD=Application Dependent (consult factory)
  Coaxial Rigid twin lead Flexible twin

lead
Rigid single lead,
segmented rigid

single lead

Flexible single
lead

Measurements
Level G G G G G
Interface (liquid/liquid) G(1) G G NR NR
Process medium characteristics
Changing density G G G G G
Changing dielectric(2) G G G G G
Wide pH variations G G G G G
Pressure changes G G G G G
Temperature changes G G G G G
Condensing vapors G G G G G
Bubbling/boiling surfaces G G AD G AD
Foam (mechanical
avoidance)

AD NR NR NR NR

Foam (top of foam
measurement)

NR AD AD AD AD

Foam (foam and liquid
measurement)

NR AD AD NR NR

Clean liquids G G G G G
Liquid with dielectric <2.5 G AD AD AD(3) NR
Coating liquids NR NR NR AD(4) AD
Viscous liquids NR AD AD AD(4) G
Crystallizing liquids NR NR NR AD AD
Solids/Powders NR NR NR AD AD
Fibrous liquids NR NR NR G G
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Table 2-1: Probe Selection Guide (continued)
  Coaxial Rigid twin lead Flexible twin

lead
Rigid single lead,
segmented rigid

single lead

Flexible single
lead

Tank environment considerations
Probe is close (<12
in./30 cm) to tank wall /
disturbing objects

G AD AD NR NR

High turbulence G G AD G AD
Turbulent conditions
causing breaking forces

NR NR AD NR AD

Tall and narrow mounting
nozzles (diameter <6 in./15
cm and height>diameter +
4 in./10 cm)

G AD NR NR NR

Probe might touch nozzle /
disturbing object

G NR NR NR NR

Liquid or vapor spray
might touch probe

G NR NR NR NR

Disturbing EMC
environment in tank

AD NR NR NR NR

(1) Not in fully immersed applications.
(2) For overall level applications a changing dielectric has no effect on the measurement. For interface

measurements a changing dielectric of the top fluid will degrade the accuracy of the interface measurement.
(3) OK when installed in pipe.
(4) For viscous or sticky applications, it is not recommended to use centering discs mounted along the probe.
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3  Mechanical installation
3.1  Safety messages

Instructions and procedures in this section may require special precautions to ensure
the safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING
Failure to follow safe installation and servicing guidelines could result in death or
serious injury.
Ensure only qualified personnel perform installation or service.
Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.
Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.
Flamepath joints are not for repair. Contact the manufacturer.

 WARNING
Explosions could result in death or serious injury.
Verify that the operating environment of the transmitter is consistent with the appropriate
hazardous locations specifications.
Temperature restrictions apply for Explosion-proof versions. For limits, see certificate-
specific information in the Rosemount 3300 Product Certifications document.
In an explosion-proof/flameproof installation, do not remove the transmitter covers when
power is applied to the unit.
Eliminate the risk of Electrostatic Discharge (ESD) discharge prior to dismounting the
transmitter head. Probes may generate an ignition-capable level of electrostatic charge
under extreme conditions. During any type of installation or maintenance in a potentially
explosive atmosphere, the responsible person should ensure that any ESD risks are
eliminated before attempting to separate the probe from the transmitter head.
Before connecting a handheld communicator in an explosive atmosphere, ensure that the
instruments are installed in accordance with intrinsically safe or non-incendive field wiring
practices.

 WARNING
Electrical shock could cause death or serious injury.
Avoid contact with the leads and terminals. High voltage that may be present on leads can
cause electrical shock.
Ensure the mains power to the transmitter is off and the lines to any other external power
source are disconnected or not powered while wiring the transmitter.
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 WARNING
Process leaks could result in death or serious injury.
Ensure that the transmitter is handled carefully. If the process seal is damaged, gas might
escape from the tank.
To avoid process leaks, only use the O-ring designed to seal with the corresponding flange
adapter.

3.2  Installation procedure
Follow these steps for proper installation:
Procedure

1. Review mounting considerations.
2. Check switches for 4-20 mA alarm output.
3. Mount the transmitter.
4. Wire the transmitter.
5. Make sure covers and cable/conduit connections are tight.
6. Power up the transmitter.
7. Configure the transmitter.
8. Verify measurements.
9. Optional: Set the write protection switch.

Note
Disconnect power supply before setting the write protection.

3.2.1  Workflow for commissioning a transmitter with Modbus®

protocol
Procedure

1. Mount the transmitter on the tank.
2. Connect the power and communication wires.
3. Establish HART® communication with the transmitter. Do one of the following:

• Connect to the MA/MB terminals (tunneling mode).
• Connect to the HART terminals.

4. Configure the transmitter.
5. Configure the Modbus communication.
6. Configure Modbus host.
7. Verify output values as reported by the transmitter.
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3.3  Before you install
3.3.1  Equipment category

The electronics enclosures are category 2G or 2D equipment. The probes not covered with
plastic and not made of titanium, are category 1G or 1D. The plastic covered probes or
probes made of titanium, are only category 1G equipment.

Figure 3-1: Equipment Category
Category 2D

Category 1D

Applicable marking:

Probes according to table

Ex tb [ia Da] IIIC T85 °C…T450 °C Db
II 1/2 D Ex ia IIIC T20085 °C…T200450 °C Da /

Category 2G

Category 1G
All probes possible

II 1/2 G Ex ia IIC T6…T1 Ga /
Ex db [ia Ga] IIC T6…T1 Gb

Applicable marking:

Category 2D

Category 2D
Probes according to Table 1-1

Applicable marking:
II 2 D Ex tb IIIC T85 °C…T135 °C Db

Probes with non-conducting surfaces and light metals
Probes covered with plastic and/or with plastic discs may generate an ignition- capable
level of electrostatic charge under certain extreme conditions. Therefore, when the probe
is used in a potentially explosive atmosphere, appropriate measures must be taken to
prevent electrostatic discharge. These probes are not allowed in dust classified areas.
The following probes do not contain plastic or PTFE material, and are allowed to be placed
in a Dust classified area:
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Table 3-1: Probes Containing no Plastic or PTFE Material
Code Material of construction: Process connection/Probe
1 316L SST (EN 1.4404)
2 Alloy C-276 (UNS N10276) plate design if flanged version
3 Alloy 400 (UNS N04400) plate design if flanged version
5 Titanium Gr-1 and Gr-2
9 Duplex 2205 (EN 1.4462/UNS S31803) (plate design if flanged version)
L Alloy 625 (UNS N06625)
M Alloy 400 (UNS N04400)
H Alloy C-276 (UNS N10276)
D Duplex 2205 (EN 1.4462/UNS S31803)

The Material of Construction Code can be found in the ninth character position of the
transmitter model code (for example 330xxxxx1xxxxxxxx).
Probes and flanges containing >7.5 percent magnesium or zirconium are not allowed
in explosive dust atmosphere. Contact your Emerson sales representative for more
information.
Probes and flanges containing light metals
When used in category 1/2G installations, probes and flanges containing titanium or
zirconium must be mounted in such a way that sparks from impact or friction between
these parts and steel cannot occur.
Separation element (EPL Ga/Gb, Da/Db)
The materials of the separation element are > 3 mm stainless steel and a 22 mm bushing
filled with 2-part epoxy. The epoxy has a continuous operating temperature of -55 °C ≤ COT
≤ 130 °C. Under normal operation the separation element is not pressurized or in contact
with the process media.

3.3.2  Alarm and write protection switches
Electronic boards are electrostatically sensitive. Failure to observe proper handling
precautions for static-sensitive components can result in damage to the electronic
components. Do not remove the electronic boards from the Rosemount 3300 Level
Transmitter.
Note
To ensure long life for your radar transmitter, and to comply with hazardous location
installation requirements, tighten covers on both sides of the electronics housing.
Table 3-2: Switch Settings
Switch bank Description Default setting Position settings
Alarm 4–20 mA alarm output High High, Low
Write protect Security write

protection
Disabled (OFF) ON = enabled, OFF =

disabled

The transmitter monitors its own operation. This automatic diagnostic routine is a timed
series of checks repeated continuously. If the diagnostic routine detects a failure in the
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transmitter, the 4–20 mA output is driven upscale (high) or downscale (low) depending on
the position of the Alarm switch.
Security write protection prevents unauthorized access to configuration data.
Related information
Signal on alarm
Saturation levels

3.3.3  Set jumpers and switches
Set alarm and write protection on the circuit board
If alarm and security jumpers are not set, the transmitter operates with the default alarm
condition HIGH and Security OFF.
Prerequisites
Write protection must be set after configuration.
Procedure

1. Remove the cover on the circuit side (see label marked circuit side).
2. To set the 4-20 mA alarm output to LOW, move the alarm switch to the LOW

position.
3. To enable the security write protection feature, move the write protect switch to the

ON position.
4. Replace the cover and tighten securely.

Figure 3-2: Circuit Board

Set alarm and write protection on the LCD display
Prerequisites
To have the LCD display override the circuit board settings, the write protection switch on
the circuit board needs to be in the OFF position and the alarm switch on the circuit board
needs to be in the HIGH position.
Procedure

1. To set the 4-20 mA alarm output to LOW, place jumper between the right and center
hole position.

2. To enable the security write protection feature, place jumper between the left and
center hole position - ON.
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Figure 3-3: LCD Display

3.4  Installation and mounting considerations
3.4.1  Recommended mounting position for liquids

When finding an appropriate mounting position for the transmitter, the conditions of
the tank must be carefully considered. The transmitter should be mounted so that the
influence of disturbing objects is reduced to a minimum. For easy access to the transmitter,
ensure that it is mounted with sufficient service space.

Figure 3-4: Mounting Position

A. Inlet pipe
B. Agitator
C. Heating coils

The following guidelines should be considered when mounting the transmitter:
• Do not mount close to inlet pipes.
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• Do not mount close to agitators. If the probe can move to within 12 in. (30 cm) away
from an agitator, the probe should be anchored.

• If the probe tends to sway due to turbulent conditions in the tank, the probe should be
anchored.

• Avoid mounting close to heating coils.
• Position the probe such that it is subject to a minimum of lateral force.
• The probe should not come into contact with the nozzle or other objects in the tank.
Note
Violent fluid movements causing high sideway forces may break rigid probes.

3.4.2  Free space requirement
If the probe is mounted close to a wall, nozzle or other tank obstruction, noise might
appear in the level signal. Therefore the following minimum clearance, according to Table
3-3, must be maintained.

Figure 3-5: Free Space Requirement

L. Clearance to tank wall

Table 3-3: Recommended Minimum Free Space for Optimal Performance
Probe type Condition Minimum clearance

(L)
Rigid single lead/Segmented rigid single lead(1) Smooth metal tank wall 4 in. (100 mm)

Disturbing objects such as pipes and beams
Plastic, concrete or rugged metal tank wall

12 in. (300 mm)

Flexible single Smooth metal tank wall 4 in. (100 mm)
Disturbing objects such as pipes and beams
Plastic, concrete or rugged metal tank wall

12 in. (300 mm)

Coaxial(1) N/A 0 in. (0 mm)
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Table 3-3: Recommended Minimum Free Space for Optimal Performance (continued)
Probe type Condition Minimum clearance

(L)
Rigid twin lead N/A 4 in. (100 mm)
Flexible twin N/A 4 in. (100 mm)

(1) Minimum clearance from tank bottom for the coaxial and rigid single probes is 0.2 in. (5 mm).

3.4.3  Flange connection on nozzles
Figure 3-6: Mounting in Nozzles

A. Confirm the nozzle does not extend into the tank.

The transmitter can be mounted in nozzles by using an appropriate flange. It is
recommended that the nozzle size is within the dimensions given in Table 3-4.
Table 3-4: Nozzle Considerations for Optimal Performance
  Single (rigid/segmented/

flexible)
Coaxial Twin (rigid/

flexible)
Recommended nozzle
diameter (D)

6 in. (150 mm) > probe diameter 4 in. (100 mm)

Minimum nozzle diameter
(D)(1)

2 in. (50 mm) > probe diameter 2 in. (50 mm)

Recommended nozzle height
(H)(2)

4 in. (100 mm) + nozzle
diameter(3)

N/A 4 in. (100 mm) +
nozzle diameter

(1) The Trim Near Zone (TNZ) function may be necessary or an Hold Off Distance/Upper
Null Zone (UNZ) setup may be required to mask the nozzle.

(2) Longer nozzles may be used in certain applications. Consult your local Emerson
representative for details.

(3) For nozzles taller than 4 in. (100 mm), the long stud version is recommended (option
code LS) to prevent the flexible portion from touching the edge of the nozzle.

Note
The probe must not be in contact with the nozzle (except for the coaxial probe).
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Narrow nozzles
For narrow nozzles it may be necessary to increase the Upper Null Zone in order to reduce
the measuring range in the upper part of the tank. By setting the Upper Null Zone equal to
the nozzle height (H), the impact on the measurement due to interfering echoes from the
nozzle will be reduced. Amplitude Threshold adjustments may also be needed in this case.

Figure 3-7: Upper Null Zone for Narrow Nozzles

A H

A. Upper Null Zone

3.4.4  Installation in still pipe/chamber
General chamber considerations
Dimensioning the chamber/pipe correctly and selecting the appropriate probe is key to the
success in these applications. When selecting a smaller chamber/pipe diameter, such as
2-in., a flexible probe is not suitable due to the chance of it coming into contact with the
walls. Also, relatively large side inlets may interfere with the signal.
When gas lift and/or turbulence may occur (e.g. boiling hydrocarbons), a 3- or 4-in.
chamber/pipe diameter is recommended for maximum measurement reliability. This is
especially true in high pressure and high temperature installations.
Table 3-5: Recommended and Minimum Chamber/Still Pipe Diameters for Different
Probes
Probe type Recommended diameter Minimum diameter
Rigid single/segmented rigid
single

3 or 4 in. (75 or 100 mm) 2 in. (50 mm)

Flexible single 4 in. (100 mm) Consult your local Emerson
representative

Rigid twin(1) 3 or 4 in. (75 or 100 mm) 2 in. (50 mm)
Flexible twin(1) 4 in. (100 mm) Consult your local Emerson

representative
Coaxial 3 or 4 in. (75 or 100 mm) 1.5 in. (37.5 mm)

(1) The center rod must be placed more than 0.6 in. (15 mm) away from the pipe wall.

Note
Metal pipes are preferred, especially in applications with low dielectric constant, to avoid
disturbances from objects near the pipe.
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Rosemount chamber
A Rosemount chamber allows external mounting of process level instrumentation. It
supports a variety of process connections, and optional drain and vent connections.
The standard Rosemount chambers are designed according to ASME B31.3. Rosemount
chambers compliant with the Pressure Equipment Directive (PED) are available. Customer
specific engineered solutions for Rosemount chambers are available upon request. Use
option code XC to order together with the Rosemount 3300 Series Transmitters.
Use a centering disc the same diameter as the chamber if the probe length >3.3 ft. (1 m).
See Table 3-8 for which disc to use.

Existing chamber
A Rosemount 3300 Level Transmitter is the perfect replacement in an existing displacer
chamber. Proprietary flanges are offered, enabling use of existing chambers to make
installation easy.

Figure 3-8: Existing Displacer Chamber

A. Replace chamber flange
B. Probe length
C. Displacer length

Considerations when changing to Rosemount 3300:
• The Rosemount 3300 Level Transmitter flange choice and probe length must be

correctly matched to the chamber. Both standard ASME and EN (DIN), as well as
proprietary chamber flanges, are available. See Proprietary flanges to identify the
proprietary flanges.

• See Table 3-8 for guidelines on which disc size to use.
• See Table 3-6 for guidelines on the required probe length.
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Table 3-6: Required Probe Length in Chambers
Chamber manufacturer Probe length(1)

Major torque-tube manufacture (249B, 249C,
249K, 249N, 259B)

Displacer + 9 in. (229 mm)

Masoneilan™ (torque tube operated), proprietary
flange

Displacer + 8 in. (203 mm)

Other - torque tube(2) Displacer + 8 in. (203 mm)
Magnetrol® (spring operated)(3) Displacer + between 7.8 in. (195 mm) to 15 in.

(383 mm)
Others - spring operated(2) Displacer + 19.7 in. (500 mm)

(1) If flushing ring is used, add the ring height to the probe length.
(2) For other manufacturers, there are small variations. This is an approximate value;

actual length should be verified.
(3) Lengths vary depending on model, SG, and rating, and should be verified.

For additional information, see the Replacing Displacers with Guided Wave Radar Technical
Note.

Probe type in chamber considerations
When installing a Rosemount 3300 in a chamber, the single lead probe is recommended.
The probe must not touch the chamber wall, should extend the full height of the chamber,
but not touch the bottom of the chamber.
The probe length determines if a single rigid or single flexible probe should be used:
• Less than 19.7 ft. (6.0 m): Rigid single probe is recommended. Use a centering disc for

probe > 3.3 ft. (1 m). When mounting space is limited, use a flexible single probe with a
weight and centering disc.

• More than 19.7 ft. (6.0 m): Use flexible single probe with a weight and centering disc.

Centering disc for pipe installations
To prevent the probe from contacting the chamber or pipe wall, centering discs are
available for flexible single, rigid single, and flexible twin lead probes. The disc is attached
to the end of the probe. Discs are made of stainless steel, Alloy C-276, Alloy 400, or PTFE.
For the segmented rigid single lead probe, up to five PTFE centering discs can be mounted
along the probe, but keep a minimum distance of two segments between the discs.
Additionally, a disc in SST or PTFE (part number 03300-1655-xxxx) can be attached to the
end of the probe.
When mounting a centering disc, it is important that it fits correctly in the chamber/pipe.
See Figure 3-9 for Dimension D. Table 3-8 shows which centering disc diameter to choose
for a particular pipe.

Figure 3-9: Dimension D for Centering Discs
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Table 3-7: Centering Disc Dimensions
Disc size Actual disc diameter (D)
2-in. 1.8 in. (45 mm)
3-in. 2.7 in. (68 mm)
4-in. 3.6 in. (92 mm)
6-in. 5.55 in. (141 mm)
8-in. 7.40 in. (188 mm)

Table 3-8: Centering Disc Size Recommendation for Different Pipe Schedules
Pipe size   Pipe schedule

5s, 5 and 10s,10 40s, 40 and 80s, 80 120 160
2-in. 2-in. 2-in. N/A(1) N/A(2)

3-in. 3-in. 3-in. N/A(1) 2-in.
4-in. 4-in. 4-in. 3-in. 3-in.
5-in. 4-in. 4-in. 4-in. 4-in.
6-in. 6-in. 6-in. 4-in. 4-in.
7-in. N/A(1) 6-in. N/A(1) N/A(1)

8-in. 8-in. 8-in. 6-in. 6-in.

(1) Schedule is not available for pipe size.
(2) No centering disc is available.

3.4.5  Installation in non-metallic tanks and open-air applications
Avoid major sources of electrical disturbance in proximity of the installation (e.g. electrical
motors, stirrers, servo mechanisms).

Figure 3-10: Avoid Electromagnetic Disturbances
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For clean liquids, use a coaxial probe to reduce effect of potential electrical disturbances.

Figure 3-11: Coaxial Probe in an Open-Air Application

For optimal single lead probe performance in non-metallic tanks, the probe must be
mounted with a metal flange, or screwed in to a metal sheet (d > 14 in./350 mm) if a
threaded version is used.

Figure 3-12: Mounting in Non-Metallic Tanks

A. Metal flange
B. Metal sheet (d > 14 in./350 mm)

3.4.6  Minimum distance between two single probes
When installing multiple Rosemount 3300 Level Transmitters with single probes in the
same tank, ensure to place the devices at proper distance from each other to avoid the risk
of interference caused by cross-talk. Table 3-9 provides recommended minimum distance
between two probes. A coaxial probe or a probe installed in a still pipe will not cause any
cross-talk.
Table 3-9: Minimum Distance between Single Probes
Product Minimum distance between probes
Oil (DC = 2.1) 5.2 ft. (1.6 m)
Water (DC = 80) 3.3 ft. (1.0 m)

3.4.7  Insulated tanks
For insulated tanks, the permitted ambient temperature is limited above a certain process
temperature. Limitations depend on the thickness of the tank insulation.
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Figure 3-13: Tank Insulation

A. Tank insulation

Related information
Temperature limits

3.5  Shorten the probe
3.5.1  Shorten the flexible single/twin lead probe

Prerequisites
Note
The PTFE covered probes must not be cut in field.
Ensure that at least 1.6 in. (40 mm) of the cable is inserted when the weight is replaced.

Figure 3-14: Shortening of Flexible Twin/Single Lead Probe

A. Spacer
B. Screws
C. Minimum: 1.6 in. (40 mm)
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Procedure
1. Mark off the required probe length. Add at least 1.6 in. (40 mm) to the required

probe length to be inserted into the weight.
2. Loosen the screws.
3. Slide the weight upwards as much as needed in order to cut the probe.

If the weight is removed from the cables, preferably apply electrical tape to the
cables before cutting, in order to avoid the cables to unwind.

4. Cut the probe. If necessary, remove a spacer to make room for the weight.
5. Slide the weight down to the required cable length.
6. Tighten the screws.

Table 3-10: Required Torque and Hex Key Dimensions
Probe Required torque Hex key dimension
Flexible twin lead 4.4 ft-lb (6 Nm) 4 mm
Flexible single lead 4 mm wire, stainless

steel
3.7 ft-lb (5 Nm) 4 mm

4 mm wire, Alloy
C-276

1.8 ft-lb (2.5 Nm) 3 mm

4 mm wire, Alloy 400 1.8 ft-lb (2.5 Nm) 3 mm

Note
If the screws are not tightened according to the required torque, the weight may fall
off. This is especially important for solid applications with high tensile loads on the
probe.

Postrequisites
After shortening the probe be sure to update the transmitter configuration to the new
probe length.

3.5.2  Shorten the rigid single lead probe
Prerequisites
The minimum probe length is 15.7 in. (400 mm).
Note
The PTFE covered probes must not be cut in field.

Note
Ensure the lead is fixed while cutting.

Procedure
1. Mark where to cut the probe.

2. Cut the probe at the mark.

Postrequisites
After shortening the probe be sure to update the transmitter configuration to the new
probe length.
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3.5.3  Shorten the rigid twin lead probe
Prerequisites
The spacers are put closer together at the probe end. The maximum amount that can be
cut is related to the ordered probe length (L).

Figure 3-15: Maximum Shortening of Rigid Twin Lead Probe

A. L > 46.5 in. (1180 mm)
B. 20.5 in. < L < 46.5 in. (520 mm < L < 1180 mm)
C. 15.7 in. < L < 20.5 in. (400 mm < L < 520 mm)
D. Maximum shortening length: 19.7 in. (500 mm)
E. Minimum probe length: 20.5 in. (520 mm)
F. Minimum probe length: 15.7 in. (400 mm)

Procedure
Cut the rods to the desired length:
• You may cut up to 19.7 in. (500 mm) from the probe end for probe length L above 46.5

in. (1180 mm)
• For probe length 20.5 to 46.5 in. (520 to 1180 mm) the minimum length is 20.5 in. (520

mm)
• For probe length 15.7 to 20.5 in. (400 to 520 mm) the minimum length is 15.7 in. (400

mm)
Postrequisites
After shortening the probe be sure to update the transmitter configuration to the new
probe length.
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3.5.4  Shorten the coaxial probe
Prerequisites

Figure 3-16: Maximum Shortening of Coaxial Probe

A. Ordered probe length (L) > 49 in. (1250 mm)
B. Ordered probe length (L) ≤ 49 in. (1250 mm)
C. Maximum shortening length: 23.6 in. (600 mm)
D. Minimum probe length: 15.7 in. (400 mm)

Procedure
1. Mark where to cut the probe.

• Pipes longer than 49 in. (1250 mm) can be shortened by as much as 23.6 in. (600
mm).

• Pipes shorter than 49 in. (1250 mm) can be cut as long as the remaining length is
not less than 15.7 in. (400 mm).

2. Insert the centering piece.
The centering piece is delivered from factory and should be used to prevent the
spacers centering the rod from coming loose.
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3. Cut the tube to the desired length.

4. Move the centering piece.

5. Cut the rod inside the tube. Ensure the rod is fixed with the centering piece while
cutting.

Postrequisites
After shortening the probe be sure to update the transmitter configuration to the new
probe length.
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3.6  Mount a centering disc
3.6.1  Mount a centering disc on flexible single/twin lead probe

Procedure
1. Mount the centering disc at the end of the weight.

13 mm

2. Secure the bolt by folding the tab washer.

3.6.2  Mount a centering disc on rigid single lead probe (8 mm)
Note
Centering discs shall not be used with PTFE covered probes.
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Procedure
1. Drill one hole using the drilling fixture (included in your shipment).

2. Mount the bushing, centering disc, and washer at the probe end.
Note
Do not mount the washer (A) if the centering disc material is PTFE, Alloy C-276, or
Alloy 400.

3. Insert the split pin through the bushing and the probe.

4. Secure the split pin.
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3.6.3  Mount a centering disc on rigid single lead probe (13 mm)
Procedure

1. Drill two holes using the drilling fixture (included in your shipment).

2. Mount the bushings and centering disc at the probe end.

3. Adjust distance by shifting hole for split pin in lower bushing.
0.16 in. (4 mm)

0.08 in. (2 mm)
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4. Insert the split pins through the bushings and the probe.

5. Secure the split pins.

3.7  Mount device on tank
Mount the transmitter with flange on a nozzle on top of the tank. The transmitter can also
be mounted on a threaded or Tri Clamp connection.

3.7.1  Tank connection with flange
Prerequisites
Note
PTFE covered probes must be handled carefully to prevent damage to the coating.

Mechanical installation Reference Manual
June 2023 00809-0100-4811

40 Rosemount 3300 Level Transmitter



Procedure
1. Place a suitable gasket on top of the tank flange.

Note
Gasket should not be used for PTFE covered probe with protective plate.

A. PTFE covered probe with protective plate

2. Lower the transmitter and probe with flange into the tank.

3. Tighten bolts and nuts with sufficient torque for the flange and gasket choice.
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4. Loosen the nut that connects the transmitter head to the probe slightly.

60 mm

5. Rotate the transmitter housing so the cable entries/display face the desired
direction.

6. Tighten the nut.

60 mm
Torque 30 ft-lb (40 Nm)

3.7.2  Tank connection with loose flange (plate design)
The transmitter is delivered with head, flange and probe assembled into one unit. If, for
some reason, these parts have been disassembled, mount the transmitter as described
below.
Prerequisites
Note
PTFE covered probes must be handled carefully to prevent damage to the coating.
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Procedure
1. Mount the flange on the probe and tighten the flange nut.

60 mm

2. Place a suitable gasket on top of the tank flange.

3. Lower the probe with flange into the tank.

4. Tighten bolts and nuts with sufficient torque for the flange and gasket choice.

5. Mount the transmitter head.
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3.7.3  Threaded tank connection
Prerequisites
Note
PTFE covered probes must be handled carefully to prevent damage to the coating.

Procedure
1. For adapters with BSPP (G) threads, place a suitable gasket on top of the tank flange.

2. For adapters with NPT threads, use anti-seize paste or PTFE tape according to your
site procedures.

3. Lower the transmitter and probe into the tank.
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4. Loosen the nut that connects the transmitter head to the probe slightly.

60 mm

5. Screw the adapter into the process connection.

52 mm / 60 mm

6. Rotate the transmitter housing so the cable entries/display face the desired
direction.

7. Tighten the nut.

60 mm
Torque 30 ft-lb (40 Nm)
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3.7.4  Bracket mounting
Procedure

1. Mount the bracket to the pipe/wall.
On pipe:

4X

A

B

A. Horizontal pipe
B. Vertical pipe

On wall:
4X

2. Mount the transmitter with probe to the bracket.

3.7.5  Tank connection with Tri Clamp
Prerequisites
Note
PTFE covered probes must be handled carefully to prevent damage to the coating.
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Procedure
1. Place a suitable gasket on top of the tank flange.

2. Lower the transmitter and probe into the tank.

3. Tighten the clamp to the recommended torque (see the manufacturer’s instruction
manual).

4. Loosen the nut that connects the transmitter head to the probe slightly.

60 mm
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5. Rotate the transmitter housing so the cable entries/display face the desired
direction.

6. Tighten the nut.

60 mm
Torque 30 ft-lb (40 Nm)
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3.7.6  Segmented probe
Segmented probe parts
Figure 3-17: Segmented Probe Parts

31.5
(800)

15.2
(385)

A

E
E
F

B

C

D G

H

D
D

J
I
I

D

A. Safety ring
B. Screw
C. Top segment
D. Split pin
E. PTFE washer (optional)
F. Centering disc in PTFE (optional)
G. Middle segment
H. Bottom segment (length varies depending on total probe length)
I. Bushing (for the centering disc at the probe end)
J. Bottom centering disc in PTFE or stainless steel (optional)

Verifying probe length
Segmented probe ordered with model code 4S
Before installation, verify the probe length (L) on the label.
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Figure 3-18: Label

A. Probe segments box
B. Probe length

Segmented probe ordered as spare part kit
Before installation, the number of segments that add up to the desired probe length must
be determined. Also, the bottom segment may need to be shortened.

Adjust the probe length
Procedure

1. Determine L, the desired probe length.

L, desired probe length:

L

2. Determine n, the number of middle segments needed for the desired probe length.
See Determination of probe segments.

n, number of middle segments:

n

3. Calculate Y, the length of the bottom segment. See Determination of probe
segments.

Y, length of bottom segment:

Y
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4. Continue as follows:
Length of bottom segment (Y) Action
Y < 0.4 in. (10 mm)

 

• Continue with Step 7. Do not use the
bottom segment.

Y ≥ 0.4 in. (10 mm)

 

• Continue with Step 5 and cut the bottom
segment.

Y = 31.5 in. (800 mm)

 

a. Add one extra middle segment to the
calculated n.

b. Continue with Step 7.

5. Mark where to cut the bottom segment.

1
2

3
4

5
6

7
8

0

1
2

3
0

6. Cut the bottom segment at the mark.
Note
Ensure the bottom segment is fixed while cutting.
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7. Optional: If a bottom centering disc is ordered, then drill two holes on the bottom
segment using the drilling fixture.

Determination of probe segments
Table 3-11: Determination of Probe Segments for Standard Seal
Desired probe length (L) Number

of middle
segments (n)

Length of bottom segment (Y)
in. mm in. mm

15.8 ≤ L ≤ 47.2 400 ≤ L ≤ 1200 0 pc Y = L -15.8 Y = L - 400
47.2 < L ≤ 78.7 1200 < L ≤ 2000 1 pc Y = L - 47.2 Y = L - 1200
78.7 < L ≤ 110.2 2000 < L ≤ 2800 2 pcs Y = L - 78.7 Y = L - 2000
110.2 < L ≤ 141.7 2800 < L ≤ 3600 3 pcs Y = L - 110.2 Y = L - 2800
141.7 < L ≤ 173.2 3600 < L ≤ 4400 4 pcs Y = L - 141.7 Y = L - 3600
173.2 < L ≤ 204.7 4400 < L ≤ 5200 5 pcs Y = L - 173.2 Y = L - 4400
204.7 < L ≤ 236.2 5200 < L ≤ 6000 6 pcs Y = L - 204.7 Y = L - 5200
236.2 < L ≤ 267.7 6000 < L ≤ 6800 7 pcs Y = L - 236.2 Y = L - 6000

Assemble the segmented probe
Prerequisites
Note
If there is enough space beside the tank, the probe can be assembled before inserting it
into the tank.
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Procedure
1. Insert the stop screw to the top segment. Tighten approximately two turns.

2. Pre-assemble the safety ring.
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3. Optional: If ordered, mount the centering disc on the bottom segment of the probe.

4. Insert the support tool.
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5. Optional: If ordered, mount the centering disc.
• Maximum five pcs/probe
• Minimum two segments between each centering disc

6. Mount a middle segment (hand tight).
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7. Secure the split pin.

8. Insert the second support tool.
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9. Remove the first support tool and lower the probe into the tank.

10. Repeat Step 5-Step 9 until all segments are mounted. Be sure to finish with the top
segment of the probe.

11. Seal and protect threads. Use anti-seize paste or PTFE tape according to your site
procedures.

 Only for NPT threaded tank connection.
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12. Attach the probe to the device.
Note
For safety reasons, at least two people are needed when mounting the device. Hold
the device above the tank. High loads can break the support tool.

A

C

D

E

B

A. Flange/Tri Clamp
B. Threaded
C. Gasket
D. Sealant on threads (NPT)
E. Gasket (BSPP (G))
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13. Tighten the stop screw and slide the safety ring into the groove.

14. Remove the support tool.
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15. Mount the device on the tank.
A B C

A. Flange
B. Tri Clamp
C. Threaded

16. Rotate the housing to the desired direction.

17. Tighten the nut.

Torque 30 ft-lb (40 Nm)

60 mm

3.8  Anchor the probe
In turbulent tanks it may be necessary to fix the probe. Depending on the probe type,
different methods can be used to guide the probe to the tank bottom. This may be needed
in order to prevent the probe from hitting the tank wall or other objects in the tank, as well
as preventing a probe from breaking.
Flexible single/twin lead probe
The flexible single lead probe itself can be used for anchoring. Pull the probe rope through
a suitable anchoring point (e.g. a welded eye), and fasten it with a chuck.
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Table 3-12: Required Torque and Hex Key Dimensions
Probe Required torque Hex key dimension
Flexible twin lead 4.4 ft-lb (6 Nm) 4 mm
Flexible single lead 4 mm wire, stainless

steel
3.7 ft-lb (5 Nm) 4 mm

4 mm wire, Alloy C-276 1.8 ft-lb (2.5 Nm) 3 mm
4 mm wire, Alloy 400 1.8 ft-lb (2.5 Nm) 3 mm

The length of the loop will add to the transition zone. The location of the clamps will
determine the beginning of the transition zone.
The Probe Length should be configured as the distance from the Upper Reference Point to
the top of the chuck.

Figure 3-19: Flexible Single Lead Probe with Chuck

A ring (customer supplied) can be attached to the weight in a threaded (M8x14) hole at the
end of the weight. Attach the ring to a suitable anchoring point.

Figure 3-20: Flexible Twin/Single Lead Probe with Weight and Ring

A

B

A. Weight with internal threads M8x14
B. Ring

A magnet (customer supplied) can be fastened in a threaded (M8x14) hole at the end of
the weight. The probe can then be guided by placing a suitable metal plate beneath the
magnet.
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Figure 3-21: Flexible Twin/Single Lead Probe with Weight and Magnet

A

A. Magnet

Rigid single lead probe
The rigid single lead probe can be guided by a tube welded on the tank bottom. Tubes
are customer supplied. Ensure that the probe can move freely in order to handle thermal
expansion. The measurement accuracy will be reduced close to the tube opening.

Figure 3-22: Rigid Single Lead Probe with Tube

A

A. Drain

Rigid twin lead probe
The rigid twin lead probe can be secured to the tank wall by cutting the center rod and
putting a fixture at the end of the outer rod. The fixture is customer supplied. Ensure the
probe is only guided and not fastened in the fixture to be able to move freely for thermal
expansion.
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Figure 3-23: Rigid Twin Lead Probe Secured to the Tank Wall

A

A. Ø 0.3 in. (8 mm)

Coaxial probe
The coaxial probe can be secured to the tank wall by fixtures fastened to the tank
wall. Fixtures are customer supplied. Ensure the probe can move freely due to thermal
expansion without getting stuck in the fixture.

Figure 3-24: Coaxial Probe Secured to the Tank Wall

A

A. Ø 1.1 in. (28 mm)

The coaxial probe can be guided by a tube welded on the tank bottom. Tubes are customer
supplied. Ensure that the probe can move freely in order to handle thermal expansion. The
measurement accuracy will be reduced close to the tube opening.

Figure 3-25: Coaxial Probe with Tube

A

A. Drain
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4  Electrical installation
4.1  Safety messages

Instructions and procedures in this section may require special precautions to ensure
the safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING
Failure to follow safe installation and servicing guidelines could result in death or
serious injury.
Ensure only qualified personnel perform installation or service.
Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.
Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.
Flamepath joints are not for repair. Contact the manufacturer.

 WARNING
Explosions could result in death or serious injury.
Verify that the operating environment of the transmitter is consistent with the appropriate
hazardous locations specifications.
Temperature restrictions apply for Explosion-proof versions. For limits, see certificate-
specific information in the Rosemount 3300 Product Certifications document.
In an explosion-proof/flameproof installation, do not remove the transmitter covers when
power is applied to the unit.
Eliminate the risk of Electrostatic Discharge (ESD) discharge prior to dismounting the
transmitter head. Probes may generate an ignition-capable level of electrostatic charge
under extreme conditions. During any type of installation or maintenance in a potentially
explosive atmosphere, the responsible person should ensure that any ESD risks are
eliminated before attempting to separate the probe from the transmitter head.
Before connecting a handheld communicator in an explosive atmosphere, ensure that the
instruments are installed in accordance with intrinsically safe or non-incendive field wiring
practices.

 WARNING
Electrical shock could cause death or serious injury.
Avoid contact with the leads and terminals. High voltage that may be present on leads can
cause electrical shock.
Ensure the mains power to the transmitter is off and the lines to any other external power
source are disconnected or not powered while wiring the transmitter.
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 WARNING
Process leaks could result in death or serious injury.
Ensure that the transmitter is handled carefully. If the process seal is damaged, gas might
escape from the tank.
To avoid process leaks, only use the O-ring designed to seal with the corresponding flange
adapter.

4.2  Power supply
For HART®, the input voltage is 11-42 V (11-30 V in IS applications, 16-42 V in Explosion-
proof / Flameproof applications). For Modbus®, the input voltage is 8-30 V.

4.3  Cable selection
The transmitter requires shielded twisted pair wiring (18-12 AWG) suitable for the supply
voltage and, if applicable, approved for use in hazardous areas.

4.4  Cable/conduit entries
The electronics housing has two entries for ½-14 NPT. Optional M20×1.5 and PG 13.5
adapters are also available. The connections must be made in accordance with local or
plant electrical codes.

Figure 4-1: Electronics Housing
A

B

D

C

E

A. Cable Entry: ½-14 NPT
Optional adapters: M20, PG13.5

B. Radar electronics
C. Dual compartment housing
D. Flanged process connections
E. Threaded process connections

Make sure that unused ports are properly sealed to prevent moisture or other
contamination from entering the terminal block compartment of the electronics housing.
Note
Use the enclosed metal plugs to seal unused ports. The plastic plugs mounted at delivery
are not sufficient as seal!

Note
Thread sealing (PTFE) tape or paste on male threads of conduit is required to provide a
water/dust tight conduit seal and to meet the required degree of ingress protection as well
as to enable future removal of the plug/gland.

Electrical installation Reference Manual
June 2023 00809-0100-4811

66 Rosemount 3300 Level Transmitter



NPT is a standard for tapered threads. Engage the gland with 5 to 6 threads. Note that
there will be a number of threads left outside the housing as illustrated in Figure 4-2.

Figure 4-2: Cable Entry with NPT Threaded Gland

A. The NPT threaded gland leaves a number of threads outside the housing

Ensure that glands for the cable entries meet requirements for IP class 66 and 67.

4.5  Wiring diagram
Figure 4-3: Non-Intrinsically Safe HART® Output

A

B

C

D

G

H

E

F

A. Rosemount 3300 Level Transmitter
B. Handheld communicator
C. Load resistance = 250 Ω
D. Power supply
E. HART modem
F. PC
G. Maximum voltage: Um = 250 V
H. HART: Un = 42.4 V

Note
Rosemount 3300 Level Transmitters with Flameproof/Explosion-proof HART Output have a
built-in barrier; no external barrier needed.
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Figure 4-4: Intrinsically Safe HART Output

A

B

H

G

CD

E

F

A. Rosemount 3300 Level Transmitter
B. Handheld communicator
C. RL= 250 Ω
D. Power supply
E. HART modem
F. PC
G. DCS
H. Approved IS barrier

IS Parameters: Ui = 30 V, Ii = 130 mA, Pi = 1 W, Li = Ci = 0

Figure 4-5: Non-intrinsically Safe Modbus® Output

C

F G

B

A

D

E C

H

A. “A” line
B. “B” line
C. 120 Ω
D. Power supply
E. RS485 Bus
F. HART +
G. HART -
H. If the unit is the last transmitter on the bus, a 120 Ω termination resistor is required.

Note
Rosemount 3300 Level Transmitters with Flameproof/Explosion-proof Modbus Output have
a built-in barrier; no external barrier needed.
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4.6  Load limitations
For HART® communication, a minimum loop resistance of 250 Ω is required. Maximum loop
resistance is determined by the voltage level of the external power supply, as given by the
following diagrams:

Figure 4-6: Non-Hazardous Installations

C

B

A

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)
C. Operating region

Figure 4-7: Intrinsically Safe Installations

C

B

A

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)
C. Operating region
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Figure 4-8: Explosion-proof/Flameproof Installations

C

B

A

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)
C. Operating region

Note
For the Explosion-proof/Flameproof installations the diagram is only valid if the HART load
resistance is at the + side, otherwise the load resistance value is limited to 300 Ω.

4.7  HART® to Modbus® converter (HMC)
4.7.1  Signal wiring

For the RS-485 bus, use shielded twisted pair wiring, preferably with an impedance of 120
Ω (typically 24 AWG) in order to comply with the EIA-485 standard and EMC regulations.
The maximum cable length is 4000 ft./1200 m.

4.7.2  Power supply cabling
The power supply cables must be suitable for the supply voltage and ambient temperature,
and approved for use in hazardous areas, where applicable.

4.7.3  Ground (common mode) voltage limit
± 7 V

4.7.4  Bus termination
Standard RS-485 bus termination per EIA-485

4.7.5  Connection terminals
The connection terminals are described in Table 4-1.

Electrical installation Reference Manual
June 2023 00809-0100-4811

70 Rosemount 3300 Level Transmitter



Table 4-1: Connection Terminals
Connector label Description Comment
HART + Positive HART connector Connect to PC with

RCT software, handheld
communicator, or other HART
configurators.

HART - Negative HART connector

MA (+) Modbus RS-485 B connection
(RX/TX+)(1)

Connect to RTU

MB (-) Modbus RS-485 A connection
(RX/TX-)(1)

PWR + Positive power input terminal Apply +8 Vdc to +30 Vdc (max.
rating)PWR - Negative power input terminal

(1) The designation of the connectors do not follow the EIA-485 standard, which states that
RX/TX- should be referred to as 'A' and RX/TX+ as 'B'.

Figure 4-9: Connection Terminals for Rosemount 3300 with HART to Modbus
Converter

B A

A. HART -
B. HART +

4.7.6  RS-485 bus
• The Rosemount 3300 Level Transmitter does not provide electrical isolation between

the RS-485 bus and the transmitter power supply.
• Maintain a bus topology and minimize stub length.
• The RS-485 bus needs to be terminated once at each end, but should not be terminated

elsewhere on the bus.

4.7.7  Installation cases
• Use common ground for Modbus Master and power supply.
• The power cables and RS-485 bus are in the same cable installation.
• A ground cable is installed and shall be used (cable size > 4 mm according to

IEC60079-14, or size according to applicable national regulations and standards). A
properly installed threaded conduit connection may provide sufficient ground.

• The cable shielding is grounded at master site (optional).
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Note
 The HART to Modbus Converter (HMC) equipped transmitter contains intrinsically safe

circuits that require the housing to be grounded in accordance with national and local
electrical codes. Failure to do so may impair the protection provided by the equipment.
Install the Rosemount 3300 Level Transmitter as shown in Figure 4-10. Up to 32 devices
may be wired on one RS-485 bus using a multidrop wiring topology.

Figure 4-10: Multidrop Connection of Rosemount 3300 Level Transmitters

A. “A” line
B. “B” line
C. 120Ω
D. RS-485 bus
E. Modbus Master
F. Power supply
G. Internal ground screw
H. External ground screw

Alternatively, the Rosemount 3300 Level Transmitter can be installed as shown in
Figure 4-11. If this wiring layout is used, there is an increased risk for communication
disturbances due to differences in potential between grounding points. By using the same
grounding point for Modbus Master and power supply, this risk is reduced.
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Figure 4-11: Alternative Multidrop Connection of Rosemount 3300 Level Transmitters

A. “A” line
B. “B” line
C. 120Ω
D. RS-485 bus
E. Modbus Master
F. Power supply
G. Internal ground screw
H. External ground screw

Star topology
For a star topology connection of the Rosemount 3300 Level Transmitter, the transmitter
with the longest cable run needs to be fitted with a 120 Ω termination resistor.

Figure 4-12: Star Topology Connection of Rosemount 3300
A

A. 120 Ω termination resistor
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4.8  Connect the transmitter
Procedure

1. Make sure the housing is grounded according to Hazardous Locations Certifications,
national and local electrical codes.
Grounding is essential for Hazardous Location safety (even for Flameproof/
Explosion Proof versions). A ground cable with a cross-sectional area of ≥ 4 mm²
must be used.

2. Verify that the power supply is disconnected.
3. Remove the cover on the terminal side (see label marked field terminals).
4. Pull the cable(s) through the cable gland/conduit.

For Explosion-proof / Flameproof installations, only use cable glands or conduit
entry devices certified Explosion-proof or Flameproof (Ex d llC (gas) or Ex t lllC
(dust)).

5. Connect the cable wires (see Wiring diagram).
6. If applicable, use the enclosed metal plug to seal any unused port.
7. Replace the cover and tighten.
8. Tighten the cable gland.
9. Connect the power supply.

4.9  Optional devices
4.9.1  Rosemount™ 333 HART® Tri-Loop™

The Rosemount 3300 outputs a HART signal with four process variables. By using the
Rosemount 333 HART Tri-Loop, up to three additional analog 4-20 mA outputs are
provided.
Each Tri-Loop channel receives power from control room. Channel 1 must be powered for
the Tri-Loop to operate.
The transmitter receives power from control room.
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Figure 4-13: Example Installation of Rosemount 333 with Rosemount 3300

B

A D

C

PV

SV

TV

QV

A. Approved IS barrier
B. DIN rail mounted Rosemount 333
C. Load resistance (≥250 Ω)
D. Control room

Related information
Rosemount 333 Reference Manual
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4.9.2  Rosemount 751 Field Signal Indicator
Figure 4-14: Wiring Diagram for the Rosemount 3300 with Rosemount 751

B

A

C

A. Rosemount 3300
B. Rosemount 751
C. Power supply
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Figure 4-15: Alternative Wiring Diagram for the Rosemount with Rosemount 751
A

B

C

A. Rosemount 3300
B. Rosemount 751
C. Power supply
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5  Configuration
5.1  Safety messages

Instructions and procedures in this section may require special precautions to ensure
the safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING
Failure to follow safe installation and servicing guidelines could result in death or
serious injury.
Ensure only qualified personnel perform installation or service.
Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.
Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.
Flamepath joints are not for repair. Contact the manufacturer.

 WARNING
Explosions could result in death or serious injury.
Verify that the operating environment of the transmitter is consistent with the appropriate
hazardous locations specifications.
Temperature restrictions apply for Explosion-proof versions. For limits, see certificate-
specific information in the Rosemount 3300 Product Certifications document.
In an explosion-proof/flameproof installation, do not remove the transmitter covers when
power is applied to the unit.
Eliminate the risk of Electrostatic Discharge (ESD) discharge prior to dismounting the
transmitter head. Probes may generate an ignition-capable level of electrostatic charge
under extreme conditions. During any type of installation or maintenance in a potentially
explosive atmosphere, the responsible person should ensure that any ESD risks are
eliminated before attempting to separate the probe from the transmitter head.
Before connecting a handheld communicator in an explosive atmosphere, ensure that the
instruments are installed in accordance with intrinsically safe or non-incendive field wiring
practices.

 WARNING
Electrical shock could cause death or serious injury.
Avoid contact with the leads and terminals. High voltage that may be present on leads can
cause electrical shock.
Ensure the mains power to the transmitter is off and the lines to any other external power
source are disconnected or not powered while wiring the transmitter.
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 WARNING
Process leaks could result in death or serious injury.
Ensure that the transmitter is handled carefully. If the process seal is damaged, gas might
escape from the tank.
To avoid process leaks, only use the O-ring designed to seal with the corresponding flange
adapter.

5.2  Overview
This chapter provides information about configuration and configuration tools. Appendix
Configuration parameters provides extended information about the configuration
parameters.

5.3  Establish HART® communication for transmitter
with HART to Modbus® Converter
Configuration is done by sending HART commands through the HART to Modbus Converter
(HMC) to the 3300 Level Transmitter electronics. To establish HART communication,
connect to the MA/MB terminals, or to the HART terminals.

5.3.1  Connect to the MA/MB terminals
The Rosemount 3300 Level Transmitter can be configured with RCT using the MA (+), MB (-)
terminals.
Prerequisites
An RS-485 Converter is required to connect to the transmitter.
Procedure

1. Connect the RS-485 Converter to the MA (+), MB (-) terminals.
2. Connect the power wires (or cycle power) to the transmitter.
3. Wait 20 seconds.
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4. In RCT, select Poll Address in the drop-down list.

Need help?
If there are multiple 3300 Modbus units on the bus with HART address 1, it will
not be possible to establish communication (by default the transmitters have HART
address 1). To establish communication in this case, make sure the transmitter is
alone on the bus. Disconnect or turn off power from any other devices.

5. Select the button to the left of the drop-down list to start polling.
6. After connection to the transmitter, perform the necessary configuration.
7. When the configuration is completed, disconnect the RS-485 Converter, connect the

Modbus communication wires, and cycle power to the transmitter.
8. Verify communication between the transmitter and the RTU is established (can take

up to 60 seconds from startup).

5.3.2  Connect to the HART terminals
To configure the Rosemount 3300 Level Transmitter, connect the communicator or PC to
the HART terminals using a HART modem. Both the configuration tool and the RS-485
bus can be connected simultaneously. Configuration data is sent with HART commands
through the HART to Modbus Converter (HMC) to the Rosemount 3300 Level Transmitter
electronics. Note that the power supply must be connected during configuration.
Note
Measurement data is not updated to the Modbus Master when a configuration tool is
connected.
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5.4  Configuration using the Radar Configuration
Tool
The Radar Configuration Tool (RCT) is a user-friendly software tool that allows you to
configure the Rosemount 3300 Level Transmitter.
You can select either of the following two methods to configure the transmitter:
• Start the Wizard for a guided installation if you are unfamiliar with the Rosemount 3300.
• Use the Setup function if you are already familiar with the configuration process or if

you just want to change the current settings.

5.4.1  Installing the Radar Configuration Tools (RCT) software
To install the RCT software:
Procedure

1. Insert the installation CD into your CD-ROM drive.
2. Follow the instructions.

Need help?
If the installation program does not automatically start, run Setup.exe from the CD.

5.4.2  Starting RCT
Prerequisites
For optimum performance set COM Port Buffers to 1.
Procedure
Select Programs → Rosemount → RCT.
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Need help?
The Help function of the RCT can be reached from the menu or by pressing the F1 key.

5.4.3  Specify the COM port
If communication is not established, open the HART Communication Server window, and
check that the right COM port is selected.
Procedure

1. Locate the HART Server icon in the lower right corner of the screen.

2. Double-click the HART Server icon.
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3. Check the COM port.

Figure 5-1: Rosemount Hart Communication Software - Server Window

4. Select the COM Port option that matches the COM Port connected to the
transmitter.

5. If communication is intermittent, increase Busy Retries and Error Retries to 5 and 5
respectively.

6. Select the Search for a device icon in the RCT tool bar.

5.4.4  Configuration using the Wizard
Configuration of a Rosemount 3300 Level Transmitter can be done using the installation
Wizard for detailed guidance.
Procedure

1. Make sure that the Tools Bar is open (Project Bar is ticked within View). Then select
the Wizard icon or select the View → Wizard menu option.

2. Select the Start button and follow the instructions.

5.4.5  Configuration using the Setup Function
If you are already familiar with the configuration procedure, or if you want to change
settings, you may use the setup function.
Procedure

1. Make sure that the Tools Bar is open (Project Bar is ticked within View). Then select
the Setup icon or select the View → Setup menu option.

2. Select the appropriate tab:
• Info (information about the device)
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• Basics
• Output
• Tank Config
• Volume (specification of tank geometry for volume calculations)
• LCD (display panel settings)
• Signal Quality Metrics (for activating/de-activating and display of signal quality

metrics, available with the DA1 option)

3. To load the parameters configured in the transmitter into the dialog window, click
the Receive Page button.

4. To load any parameter changes back to the transmitter, click the Send Page button.

Setup - Basics
Units
Length, volume, and temperature units can be set. Units are used wherever measurement
and configuration data occur.

Setup - Output
Range values
The Lower Range value = 4 mA value
The Upper Range value = 20 mA value
The 4-20 mA range must not include the upper or lower Transition Zone.
Variable assignment
Rosemount 3301 available measuring parameters: Level, Distance to Level, Total Volume.
For fully immersed probe: Interface Level and Interface Distance.
Rosemount 3302 available measuring parameters: Level, Distance to level, Total Volume,
Interface Level, Interface Distance, and Upper Product Layer Thickness.
In the Primary Variable field, the measuring parameter is entered for the analog signal.
More variables can be assigned if the superimposed digital HART® signal or a HART
Tri-loop™ is used.
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Setup - Tank Config

Geometry
See tank picture in window.
• Set Reference Gauge Height
• Set Upper Null Zone (if needed)
• Set Mounting Type
• Set Diameter (if Mounting Type is Nozzle or Pipe/Chamber)
• Set Nozzle Height (if Mounting Type is Nozzle)
Probe
• Set Probe Type (This parameter is pre-configured at factory.)
• Set Probe Length (This parameter is pre-configured at factory. The probe length needs

to be changed if the probe is cut in field.)
• Set Probe Angle
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• If Remote Housing is mounted, set the Remote Housing length (setting not available in
DD/DTM™)

Miscellaneous settings
• Set Vapor Dielectric value (if needed)
• Set Upper Product Dielectric value (interface measurements only)

5.4.6  Additional configuration to fine-tune performance
To fine-tune the transmitter’s performance, it is recommended the Trim Near Zone
function be executed after configuration is finished.
Related information
Trim Near Zone function

5.5  Change Modbus communication parameters
5.5.1  Change Modbus communication parameters using RCT

To change the Modbus address and communication parameters in Rosemount Radar
Configuration Tools (RCT):
Prerequisites
The Modbus Setup function is available in RCT version 2.03.0002 and later.
To change Modbus communication parameters, the Rosemount 3300 Level Transmitter
must use HART address 1, the default address.
Procedure

1. Start RCT and connect to the transmitter.
2. In the RCT workspace Project Bar, select the Setup icon to open the Setup window.
3. Select the Output tab.
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4. Select Modbus Setup.

5. In the Modbus Setup window, select Modbus protocol and enter the desired Modbus
address.

6. Enter the baud rate, parity, and stop bits, then select OK.
It is also possible to enter a user-defined Modbus Message in the Modbus String
area.

Postrequisites
After changing communication parameters, disconnect the HART modem and wait at least
60 seconds for the change to take effect. In case the MA (+)/MB (-) terminals are used for
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connection to the HMC, disconnect the RS-485 Converter, cycle power to the transmitter
and wait up to 60 seconds for the change to take effect.
Related information
Modbus communication protocol configuration

5.5.2  Change Modbus communication parameters using a
handheld communicator
The Modbus communication parameters can be changed by entering a text string in the
HART Message parameter.
Related information
Modbus communication protocol configuration

5.6  Configure the alarm output for the Modbus®

transmitter
Prerequisites
If the Modbus communication setup has been changed, but the transmitter has not yet
started to use the new configuration, then you need to disconnect the HART modem and
wait up to 60 seconds for the change to take effect.
In case the MA/MB terminals are used for connection to the HART to Modbus Converter
(HMC), disconnect the RS-485 Converter, cycle power to the transmitter and wait up to 60
seconds for the change to take effect.
The Modbus communication settings will otherwise be lost if you write a new message to
the transmitter.
Procedure

1. Start RCT and connect to the transmitter.
2. In the RCT workspace Project Bar, select the Setup icon to open the Setup window.
3. Select the Output tab.
4. Select Modbus Setup.
5. Enter the Modbus Message, and then select OK.
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Postrequisites
After changing the Alarm Output configuration, disconnect the HART modem and wait up
to 60 seconds for the change to take effect. In case the MA (+)/MB (-) terminals are used for
connection to the HMC, disconnect the RS-485 Converter, cycle power to the transmitter,
and wait up to 60 seconds for the change to take effect.

5.6.1  Modbus alarm output strings
Table 5-1: Available Alarm Output Text Strings
Protocol String Alarm output
Modbus RTU HMC EN Not a number (NaN), default

HMC EF Freeze, hold last value
HMC EU U-0.1 User defined value, -0.1 in this

example
Levelmaster HMC M2 EH High value, 999.99, default

HMC M2 EL Low value, -99.99
HMC M2 EF Freeze, hold last value
HMC M2 EU U0 User defined value (range -99.99

to 999.99), 0 in this example
Modbus ASCII HMC M1 EN Not a number (NaN), default

HMC M1 EF Freeze, hold last value
HMC M1 EU U-0.1 User defined value (range -99.99

to 999.99), -0.1 in this example

5.6.2  Verify alarm output
To verify the alarm output, simulate a device failure by removing the transmitter head.
Related information
Replace the transmitter head

5.6.3  Use status information to evaluate measurement validity
The transmitter updates status information about the current measurement, and this
status information is available as a bitfield register through Modbus communication.
By monitoring the status information it is possible to determine if the current
measurement output value is valid.
Related information
Common Modbus host configuration

5.6.4  Use Heartbeat to detect errors
By reading and evaluating the Heartbeat value from the device, it is possible to verify that
the communication link between the transmitter, HMC, RTU and even the control system
communicating with the RTU is working.
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Assign Heartbeat to one of the transmitter variables (SV, TV, or QV). Heartbeat is increased
by one for each measurement cycle in the device (until it eventually starts over at zero
again).
In case this value is not updated, it means that the communication link is broken.

5.7  Advanced configuration
5.7.1  Set user defined upper reference point

If you want to specify your own upper reference point, you can do this by setting the
Calibration Offset parameter.

Figure 5-2: User Defined Upper Reference Point

A

B

C
D

E

A. Upper reference point
B. Reference gauge height
C. Calibration offset
D. Transmitter reference point
E. Product level

Procedure
1. Adjust the reference gauge height to the distance from the tank bottom to the

desired upper reference point.
2. Add the distance between the upper reference point and the transmitter reference

point to the calibration offset value that is stored in the transmitter database.
a) In RCT, open the Tools section in the project bar.
b) Select Device Commands → Basics → Set Calibration Offset.
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5.8  HART® multi-drop configuration
The Rosemount 3300 Level Transmitter can be run in multidrop mode. In the multidrop
mode each transmitter has a unique HART address.

Figure 5-3: Multidrop Connection

5.8.1  Change the poll address
To set the desired address for multidrop operation:
Procedure

1. In RCT, select View → Device Commands, or select the Device Commands icon from
the Project Bar Advanced section.

2. Open the Details folder.
3. Select the Set Poll Address option.
4. Set the desired address.

5.9  Use with the Rosemount 333 HART® Tri-Loop™

To prepare the transmitter for use with a Rosemount 333 HART Tri-Loop, the transmitter
must be configured to Burst Mode and the process variable output order must be set.
Procedure

1. Make sure the Rosemount 3300 Level Transmitter is properly configured.
2. If RCT is used for the Rosemount 3300 Series setup, it is recommended that the

receive buffer and transfer buffer for the selected COM port are adjusted.
Otherwise, Burst Mode cannot be turned off by RCT.

3. In RCT, select Setup → Output and assign transmitter variables primary variable,
secondary variable etc.

4. Select Setup → Basics and configure the variable units (length, volume, and
temperature).

5. Set the Rosemount 3300 in Burst Mode.
Select Device Commands → Details → Set Burst Mode.

6. Select Burst option 3 = Process variables and current (Process vars/crnt).
7. Prior to exiting the configuration, note the selected variables for SV, TV, and QV, and

the units set for each of the variables. The same configuration must be used for the
Rosemount 333.
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Related information
Rosemount 333 Reference Manual

5.9.1  Set the COM port buffers in Windows XP
The receive and transfer buffers need to be adjusted to be able to communicate with the
Rosemount 3300 in Burst Mode.
Procedure

1. In the MS Windows™ Control Panel, open the System option.
2. Select the Hardware tab and then select the Device Manager button.
3. Expand the Ports node in the tree view.
4. Right-click on the selected COM port and select Properties.
5. Select the Port Settings tab and then select the Advanced button.
6. Drag the Receive Buffer and Transfer Buffer slides to 1.
7. Select the OK button.
8. Reboot the computer.

5.9.2  Set the COM port buffers in Windows 7, 8, or 8.1
The receive and transfer buffers need to be adjusted to be able to communicate with the
Rosemount 3300 in Burst Mode.
Procedure

1. In the Start menu, select Control Panel → System and Security → System → Device
Manager.

2. Double-click Ports (COM & LPT).
3. Right-click on the selected COM port and select Properties.
4. Select the Port Settings tab and then select the Advanced button.
5. Drag the Receive Buffer and Transmit Buffer to 1.
6. Click OK.
7. Restart the computer.
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6  Operation
6.1  Display functionality

The Rosemount 3300 Level Transmitter uses the display for presentation of measurement
variables. The display has two rows. The upper row with five characters is for the measured
value, and the lower row with six characters is for the value name and measurement unit.
The display toggles between the different variables every two seconds.

Figure 6-1: Presentation of Measurement Data

D

A

A

B

C

A. Jumpers for alarm and write protection settings
B. Measurement value
C. Measurement unit
D. Measurement variable
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6.1.1  Variable screens
The transmitter can display the following variables:
Table 6-1: Display Parameters
Parameter Description
Level Level Product level
Distance Distance from the upper reference point to the product surface
Volume Total product volume
Internal Temp Temperature inside the transmitter housing
Interface Distance Distance between the upper reference point and the interface between the

upper and lower product
Interface Level Level of the lower product
Interface Thickness Thickness of the upper product
Amplitude Peak 1 Signal amplitude of the reflected signal from the reference peak
Amplitude Peak 2 Signal amplitude of the reflected signal from the product surface
Amplitude Peak 3 Signal amplitude of the reflected signal from the surface of the bottom

product (interface measurements)
Percent Range Level value in percent of total measurement range
Analog Out Current 4 -20 mA current
Signal Quality Information on signal quality
Surface/Noise Margin Information on surface/noise margin

6.2  Error messages
The display can also be used for presentation of software errors. The upper row shows
error codes and the lower row shows 'ERROR'.

Figure 6-2: Presentation of Error Messages

A

A. Error code
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7  Service and troubleshooting
7.1  Safety messages

Instructions and procedures in this section may require special precautions to ensure
the safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING
Failure to follow safe installation and servicing guidelines could result in death or
serious injury.
Ensure only qualified personnel perform installation or service.
Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.
Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.
Flamepath joints are not for repair. Contact the manufacturer.

 WARNING
Explosions could result in death or serious injury.
Verify that the operating environment of the transmitter is consistent with the appropriate
hazardous locations specifications.
Temperature restrictions apply for Explosion-proof versions. For limits, see certificate-
specific information in the Rosemount 3300 Product Certifications document.
In an explosion-proof/flameproof installation, do not remove the transmitter covers when
power is applied to the unit.
Eliminate the risk of Electrostatic Discharge (ESD) discharge prior to dismounting the
transmitter head. Probes may generate an ignition-capable level of electrostatic charge
under extreme conditions. During any type of installation or maintenance in a potentially
explosive atmosphere, the responsible person should ensure that any ESD risks are
eliminated before attempting to separate the probe from the transmitter head.
Before connecting a handheld communicator in an explosive atmosphere, ensure that the
instruments are installed in accordance with intrinsically safe or non-incendive field wiring
practices.

 WARNING
Electrical shock could cause death or serious injury.
Avoid contact with the leads and terminals. High voltage that may be present on leads can
cause electrical shock.
Ensure the mains power to the transmitter is off and the lines to any other external power
source are disconnected or not powered while wiring the transmitter.

Reference Manual Service and troubleshooting
00809-0100-4811 June 2023

Rosemount 3300 Level Transmitter 97

https://www.emerson.com/documents/automation/75670.pdf


 WARNING
Process leaks could result in death or serious injury.
Ensure that the transmitter is handled carefully. If the process seal is damaged, gas might
escape from the tank.
To avoid process leaks, only use the O-ring designed to seal with the corresponding flange
adapter.

7.2  Diagnostic messages
7.2.1  View diagnostic messages

Procedure
1. Select the Read Gauge Status  icon in the toolbar at the top of the RCT workspace.
2. Open the Tools section in the RCT workspace project bar and select the Device Cmds

icon, or select the Device Commands option from the View menu.
3. Open the folder named Diag and double-click the Read Gauge Status option.

7.2.2  Errors
Error messages are shown on the Integral Display, on the handheld communicator, or in
the RCT software. Errors normally result in an analog output alarm, and are indicated in
RCT by the message “Transmitter Malfunction”.

Figure 7-1: Transmitter Malfunction

Invalid configuration
LCD error code
CNFIG
Cause
At least one configuration parameter is outside the allowed range.
Note
The default values are used until the problem is solved.

Recommended actions
1. Load default database and restart the transmitter.
2. If the condition persists, contact your local Emerson representative.
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RAM failure
LCD error code
00001
Cause
RAM failure was detected during startup test. The transmitter performs an immediate
reset.

Recommended actions
Contact your local Emerson representative.

FPROM failure
LCD error code
00002
Cause
FPROM failure was detected during startup test. The transmitter performs an immediate
reset.

Recommended actions
Contact your local Emerson representative.

Waveform acquisition failure
LCD error code
00006
Cause
This error is probably caused by hardware failure.

Recommended actions
Contact your local Emerson representative.

EEPROM factory checksum
LCD error code
00007
Cause
Checksum error in the factory configuration parameters. Can be caused by power failure
during configuration or by hardware error.
Note
The default values are used until the problem is solved.

Recommended actions
Contact your local Emerson representative.
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EEprom user checksum error
LCD error code
00008
Cause
Caused by error in the User Configuration parameters. Can be caused by power failure
during configuration or by hardware error.
Note
The default values are used until the problem is solved.

Recommended actions
1. Load default database and restart the transmitter.
2. If the condition persists, contact your local Emerson representative.

Software error
LCD error code
00010
Cause
An error has been detected in the transmitter software.

Recommended actions
Contact your local Emerson representative.

Probe failure
LCD error code
00013
Cause
Probe is not detected.

Recommended actions
Check that the probe is correctly mounted.

7.2.3  Warnings
Warning messages are shown on the Integral Display, on the handheld communicator, or
in the RCT software. Warnings are less serious than errors, and in most cases do not result
in analog output alarms. The warnings are indicated by a message at the bottom of the
RCT workspace.

Reference peak not found
Cause
• Reference peak immersed in high dielectric liquid
• Wrong threshold level T1
• Hardware error
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Recommended actions
1. View the waveform plot and check amplitude threshold T1.
2. Check that the tank is not overfull.

No level peak is found
Cause
• Wrong threshold level T2
• Liquid level in transition zone or below probe end

Recommended actions
View the waveform plot and check amplitude threshold T2.

Interface peak not found
Cause
• Wrong threshold level T3
• Interface level too close to the upper product level
• No level peak detected

Recommended actions
View the waveform plot and check amplitude threshold T3.

Internal temperature out of range
Cause
The temperature of the electronics board has exceeded the transmitter’s operating range.

Recommended actions
Contact your local Emerson representative.

Volume computation warning
Cause
• Volume configuration error
• Strapping table error

Recommended actions
1. Check that the correct tank type is selected for volume configuration.
2. Check that the tank dimensions for volume are correct.
3. If strapping table is used, check the level vs. volume points.

Immersed probe
Cause
• Wrong threshold level T4
• Reference peak immersed in liquid
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Recommended actions
View the waveform plot and check amplitude threshold T4.

7.3  Troubleshooting guides
If there is a malfunction despite the absence of alerts, follow the procedures described in
the appropriate troubleshooting guide. Under each of the symptoms, specific suggestions
for solving problems are offered.

7.3.1  Troubleshooting incorrect level readings
Interface Level is reported as Not A Number (NAN)
Both P2 and P3 are detected but Interface Level is reported as Not A Number (NAN) in the
waveform plot.
Possible cause
Measurement Mode is set to “Level Only”.

Recommended actions
Set Measurement Mode to “Level and Interface”.

Level and interface level are reported as NAN
Possible cause
Probe is not connected

Recommended actions
Use the command “Read Gauge Status” and check if error “Probe Failure” is active. If
this is the case, check the probe connection.

Interface level is equal to the product Level
Both P2 and P3 are detected but the interface level is equal to the product Level.
Possible cause
• P3 is identified as a double bounce.
• P2 and P3 are very close.

Recommended actions
Adjust thresholds T2 and T3.

Level is incorrectly reported as full or empty
P2 is detected but level is incorrectly reported as full or empty.

Recommended actions
Use the command “Read Gauge Status” and check if the warning “Probe Immersed” is
active. If this is the case:

a) Check that the transmitter is configured with correct probe type
b) Check that the reference peak (P1) is below amplitude threshold T4. If not,

adjust T4 to an appropriate value.
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Reference peak is not detected
Possible cause
• The tank is full.
• The transmitter is configured with wrong probe type.
• Amplitude Threshold T1 is not correct.

Recommended actions
1. Check the product level.
2. Check that the correct probe type is configured.
3. Check amplitude threshold T1.

Level accuracy seems off
Possible cause
Configuration error

Recommended actions
1. Check the reference gauge height parameter.
2. Check status information and diagnostic information.

7.3.2  There is no HART communication (lost device
communication)

Recommended actions
1. Verify power supply voltage is adequate at signal terminals.
2. Check load resistance (250 ohms minimum).
3. Check if device is at an alternate HART address.
4. Check current analog output value to verify that device hardware works.

7.3.3  Troubleshooting the HART® to Modbus® Converter
No communication on RS-485 bus (MA, MB)

Recommended actions
1. Check that the cables are connected.
2. Check that PWR+ is connected to + and PWR- is connected to - on the power

supply.
3. Ensure the Rosemount 3300 Level Transmitter is supplied with 8-30 Vdc

(max. rating).
4. Try alternating MA/MB if you are unsure of the polarity.
5. If an RS-485 converter is used, make sure it is properly installed and configured.
6. The last Rosemount 3300 Level Transmitter may need a terminating 120Ω

resistor connected between MA and MB.

Reference Manual Service and troubleshooting
00809-0100-4811 June 2023

Rosemount 3300 Level Transmitter 103



No communication in RCT using HART+, HART-
Recommended actions

1. Verify the HART modem is properly connected.
2. Check if device is at an alternate HART address (default 1).

No communication in RCT using MA, MB
Recommended actions

1. Check if device is at an alternate HART address (default 1).
2. Cycle the power and wait 20 seconds before polling.

Related information
No communication on RS-485 bus (MA, MB)

No communication with Modbus RTU protocol
Recommended actions

1. Make sure the Modbus communication protocol configuration is done properly.
2. Make sure the Modbus RTU address is unique on the bus.
3. Cycle the power and try to connect.
4. Check the RTU communication settings.

Related information
No communication on RS-485 bus (MA, MB)
Modbus communication protocol configuration

No communication with Modbus ASCII protocol
Recommended actions

1. Make sure the Modbus communication protocol configuration is done properly.
2. Make sure the Modbus ASCII address is unique on the bus.
3. Cycle the power, waiting 40 seconds before communication begins.
4. Check the RTU communication settings.

Related information
No communication on RS-485 bus (MA, MB)
Modbus communication protocol configuration

No communication with Levelmaster protocol
Recommended actions

1. Make sure the Modbus communication protocol configuration is done properly.
2. Make sure the Levelmaster address is unique on the bus.
3. Cycle the power, waiting 40 seconds before communication begins.
4. Check the RTU communication settings.

Related information
No communication on RS-485 bus (MA, MB)
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Modbus communication protocol configuration

7.3.4  Analog out is set in alarm
Recommended actions
Use the command “Read Gauge Status” to check active errors.

7.3.5  Integral display does not work
Recommended actions

1. Check the display configuration.
2. Check loop power.
3. Check display connection.

7.4  Service and troubleshooting tools
7.4.1  Waveform plot function

The Radar Configuration Tool (RCT) has powerful tools for advanced troubleshooting. By
using the Waveform Plot function, you get an instant view of the tank signal. Measurement
problems can be solved by studying the position and amplitude of the different peaks.

Figure 7-2: Waveform Plot

-

A
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B

A. Amplitude
B. Distance
C. Upper Null Zone

Echo peaks
In a typical measurement situation the following peaks appear in the diagram:
P1 - Reference peak
This peak is caused by the transition between transmitter head and probe. It is used by the
transmitter as a reference at level measurements.
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P2 - Product surface peak
This peak is caused by a reflection on the product surface. In Measurement Mode =
Interface when Immersed Probe however, P2 indicates the interface since the surface of
the upper product is ignored.
P3 - Interface or probe end peak
This peak is caused by reflection on the interface between an upper product and a bottom
product with a relatively high dielectric constant. It may also be caused by the probe end
if there is no product above. This peak is shown when the transmitter is in Measurement
Mode = Level & Interface.

Amplitude thresholds
Different amplitude thresholds are used in order to filter out unwanted signals. The
following amplitude thresholds are used for the Rosemount 3300 Level Transmitter:
T1 - Reference threshold
Amplitude threshold for detection of the reference peak P1.
T2 - Surface threshold
Amplitude threshold for detection of the product level peak P2.
T3 - Interface threshold
Amplitude threshold for detection of the interface level peak P3.
T4
Amplitude threshold that is used to detect whether the probe is fully immersed in the
upper product or not.

Plot the measurement signal
Procedure

1. Start the RCT program.
2. Select View → Plotting, or select the Plotting icon in the RCT workspace (Tools page

at the left side of the workspace).
3. Select the Read  button.

Log and save the waveform plot to disk
The waveform plot can be automatically logged and saved to file by specifying the read
plot interval and the number of plots to log. For each new file, the corresponding number
is appended to the end of the file name.
Procedure

1. Select the Read Plot Interval  button and enter a time interval.
The Read Plot Interval specifies the time interval between plots that are saved to
disk.
Example
For example, type 10 if you want the waveform plot to be updated every ten
minutes.
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2. Select the Number of plots  button and specify the maximum number of
plot files.
The default value is 100.

3. Make sure that Read Action type is set to Multiple Read. Otherwise, RCT will only
save one log file.

4. Select the Start disk logging  button to start the log.

Figure 7-3: Disk Logging Waveform Plot

5. Select a destination folder and enter a file name.

7.4.2  Amplitude thresholds
Measurement with the Rosemount 3300 is based on the fact that the radar signal
pulses are reflected by the product surface and the interface between two liquids. Signal
amplitude thresholds are used to separate the measurement signal from disturbing
echoes and noise.
The transmitter uses certain criteria to decide which type of pulse that is detected. For
example, counting from the top of the tank, the first echo found above the Surface
Threshold is considered as the product surface, as illustrated in Figure 7-4. Other pulses
further away from the top, although above the Surface Threshold, are ignored. When the
surface echo is found, the next pulse below the product surface and with a signal strength
above the Interface Threshold, is considered as the Interface.
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Figure 7-4: Threshold Principle

3.0

A. The echo peak is below the threshold (dotted line) and is suppressed by the device.
B. This echo peak is interpreted as the product surface, since it is the first peak closest to

device that is above the surface threshold.
C. Threshold
D. Amplitude
E. Distance

By default, the amplitude thresholds are automatically adjusted to appropriate values in
order to filter out noise and other non-valid measurements from the measurement signal.
The configured Upper Product Dielectric Constant is used for setting the automatically
calculated amplitude thresholds. Normally no other threshold adjustment is needed. But if
the transmitter still does not track for example the product surface, it may be necessary to
manually adjust the thresholds.

Guidelines for setting the amplitude thresholds
Normally, the amplitude thresholds are automatically set by the transmitter, and no
manual settings are needed. However, due to the properties of the product, it may in
rare cases be necessary to adjust the amplitude thresholds for optimum measurement
performance.
• The thresholds T2 and T3 should be set to about 50% of the measured signal amplitude

for the product surface and the interface peaks, respectively.
• Amplitude thresholds should not be set to values less than 3.
• If possible, T3 should be higher than T2.

Adjust the amplitude thresholds
Prerequisites
Note
Before changing the amplitude thresholds, check that the Upper Product Dielectric
Constant parameter is set as accurately as possible. The Upper Product Dielectric Constant
is used for setting the automatically calculated amplitude thresholds.

Procedure
1. Start RCT.
2. Select the Device Commands option from the View menu.
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3. Open the Details folder.
4. Select the Set Nominal Thresholds option.

Note
Default amplitude thresholds can be set by typing 0 as the new threshold value.

Example 1: Product surface peak not found
If the transmitter does not track the product surface correctly, it may be necessary to
adjust the threshold values. In Figure 7-5, the Surface Threshold is too high and as a result
the product level will not be detected. In a situation like this, the Surface Threshold has to
be lowered so that the surface peak is not filtered out.

Figure 7-5: Surface Threshold Is Too High

A. Amplitude
B. Distance
C. Surface Threshold is above the Product Surface peak.

If there are disturbing objects in the tank, the Surface Threshold must be carefully set to
avoid locking on the wrong amplitude peak. In Figure 7-6, the Surface Threshold is too
low, and as a result the transmitter has locked on a peak above the actual product surface.
A disturbance was interpreted as the product surface, since this was the first amplitude
peak closest to device that went above Surface Threshold. The actual product surface was
interpreted as the interface or the probe end.
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Figure 7-6: Surface Threshold Is Too Low

0

A. Amplitude
B. Distance
C. Disturbing echo misinterpreted as product surface
D. Actual product surface

By adjusting the Surface Threshold the product surface is properly detected as illustrated
in Figure 7-7.

Figure 7-7: Echo Curve Plot after Surface Threshold Was Adjusted

A. Amplitude
B. Distance
C. After Surface Threshold is adjusted the product surface is correctly detected.

Example 2: Interface peak not found
In interface applications where the bottom product has a relatively low dielectric constant
(<40), or if the signal is attenuated in the upper product, the amplitude of the reflected
signal from the interface is relatively low and difficult for the transmitter to detect. In such
a case it may be possible to detect the reflected signal from the interface if the Interface
Threshold is adjusted.
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Figure 7-8 illustrates a situation where the Interface Threshold is too high. The signal
amplitude peak at the interface between the upper and lower products is not detected in
this case.

Figure 7-8: Echo Curve Plot Indicating that the Interface Threshold for the Interface
Peak Is Too High

A. Amplitude
B. Distance
C. Surface Threshold
D. Product Surface Peak
E. The Interface Threshold is above the Interface Peak.

By adjusting Interface Threshold, the peak at the interface between the upper and lower
products is detected as illustrated in Figure 7-9.

Figure 7-9: After Changing the Interface Threshold the Transmitter Detects the
Interface

A. Amplitude
B. Distance
C. Surface Threshold
D. After Interface Threshold is adjusted the interface is correctly detected.
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7.4.3  Calibrate analog output
Procedure

1. Start RCT and make sure the transmitter communicates with the PC.
2. Under Tools, select the Device Cmds icon, or select the Device Commands option

from the View menu.
3. Open the folder named Diag and double-click the Fixed Current Mode option.

4. Set the output current to 4 mA.

5. Measure the output current.
6. Open the folder named Details.
7. Select the Trim DAC Zero option and enter the measured output current.
8. In the Diag folder, double-click the Fixed Current Mode option, and set the output

current to 20 mA.
9. Measure the output current.

10. In the Details folder double-click the Trim DAC Gain option, and enter the measured
output current.

11. In the Diag folder double-click the Fixed Current Mode option, and set the output
current to 0 mA in order to leave the Fixed Current Mode.
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7.4.4  Calibrate distance and level
Prerequisites
Ensure that:
• The product surface is calm.
• The tank is not being filled or emptied.
A complete calibration is performed in two steps:
Procedure

1. Calibrate distance measurement by adjusting the calibration offset parameter.
2. Calibrate level measurement by adjusting the reference gauge height.

Calibrate distance
Procedure

1. Measure the actual distance between the upper reference point and the product
surface.

Figure 7-10: Distance Calibration

A

B

A. Upper reference point
B. Distance

2. Adjust the calibration offset so that the distance measured by the transmitter
corresponds to the actual distance.

a) In RCT, open the Tools section in the project bar.
b) Select Device Commands → Basics → Set Calibration Offset.
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Calibrate level
Procedure

1. Measure the actual product level.

Figure 7-11: Distance and Level Calibration
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A. Upper reference point
B. Reference gauge height
C. Level

2. Adjust the reference gauge height so that the measured product level corresponds
to the actual level.

7.4.5  Logging measurement data
Procedure

1. Select the Monitor icon in the RCT workspace, or select the Monitor option from the
View menu.

2. Select the desired variables to be monitored and select the Start Monitor  button.

Save the log to disk
Procedure

1. Select the desired variables to be monitored.
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2. Select the Log interval  button and enter a time interval.
Example
For example, type 10 if you want data to be logged in every tenth second.

3. Select the Counter  button and enter the maximum number of files to be
stored.

4. Select the desired options for timer, time, and date.
By selecting a check-box, the corresponding time indication is stored for each log
entry in the log file.

5. Select the Start disk logging  button.
6. Select a destination folder and enter a file name.

Counter
The Counter is used to limit the amount of data stored on the hard disk. Each time the
maximum number of entries in a log file is reached, the current log file is saved and a
new file is created. This procedure continues up to the maximum number of files given by
the counter value. The file size is limited to 60,000 entries which can easily be handled by
spreadsheet programs like MS Excel.

7.4.6  Saving the transmitter configuration
The RCT offers different methods to save the current transmitter configuration:
• Save only the configuration specified in the Setup window.
• Use the more extensive function in the Memory Map window.
You can use a stored configuration file as a backup of the current configuration, or it can
be distributed for service purposes.

Save the current transmitter setup
Procedure

1. Select the Setup icon in the RCT workspace, or select the Setup option from the View
menu to open the Setup window.
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2. Right-click and select the Receive All option, or from the Setup menu, select the
Receive All option.
Alternatively, you can use the Receive Page option on each individual page.
Note
All pages must be received before the setup can be saved.

3. Right-click and select the Save Setup option.
4. Select a destination folder and enter a file name.

5. Select Save.

Memory map
The Memory Map window allows you to view the current transmitter database registers. It
is also possible to save the current database for backup or service purposes, and it is also
possible to download a backup database to the transmitter.

Save configuration data in the memory map window
Procedure

1. Start the RCT program.
2. Select View → Memory, or select the Memory Map icon in the RCT workspace

(Advanced section at the left side of the workspace window).
3. Select the All EE option from the drop-down list.
4. Select Receive.

It may take a few minutes to read the database.
5. Right-click and select Save Memory As.
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6. Type the desired file name and select OK.
Now the current database is stored.

Need help?
See the online help in RCT for further information on how to open a saved database and
how to download a database to the transmitter.

7.4.7  Load a setup
Procedure

1. Select Setup in the RCT workspace, or select File → Setup.
2. In the Setup window, right-click and select the Open Setup option, or from the File

menu, select the Open Setup option.
3. Open the source folder and select the desired setup file.
4. Select Open.

7.4.8  Upgrade the HART® to Modbus® Converter firmware
The HMC's firmware is upgraded using Rosemount Radar Master.
Prerequisites
Note
All settings in the HART to Modbus converter (HMC) will be lost after upgrading the
transmitter. Reconfiguration of Modbus communication setup and alarm handling is
required after completing the upgrade.

Note
During firmware upgrade, the HMC Modbus RTU address must be 246, the default address.
Ensure to disconnect other Modbus RTU devices that are connected and have address 246.

Note
Do not interrupt communication between the PC and the Rosemount 3300 Level
Transmitter during the firmware upload.

Procedure
1. Start Rosemount Radar Master.
2. Enable Modbus communication and set communication preferences.

a) Select View → Communication Preferences.
b) Select the Modbus tab.
c) Select the Enable Modbus Communication checkbox.
d) In the Port list, select the COM port number that the RS-485 Converter is

connected to.
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e) Select Advanced and use the following settings:
• Modem: RS-485
• Baudrate: According to configuration in HMC (default 9600)
• Stop Bits: According to configuration in HMC (default 1)
• Parity: According to configuration in HMC (default None)
• Handshake: RTS/CTS
• Response Timeout: 1000 ms
• Retries: 3

f) Select OK.

3. Search for and connect to device.
a) Select Device → Search to open the Search Device window.

If the HMC is configured for Modbus ASCII or Levelmaster communication,
cycle the power to the transmitter and then open the Search Device window.
The HMC will then communicate using Modbus RTU for 20 seconds and under
that time it is possible to connect with Rosemount Radar Master.

b) In the Protocols(s) list, verify that Modbus is selected.
c) Select Scan Address Range, and type a start and end address.

The default HMC Modbus address is 246.

d) Select Start Scan.
e) Select OK to connect when the device is found.

4. Ensure the HMC Modbus address is set to 246 (the default address).
a) Select Setup → General.
b) In the Device Address box, type 246 and select Store.

5. Enter service mode.
a) Select Service → Enter Service Mode.
b) Type the password and select Submit.

The default password is "admin".

6. Upload HMC firmware to device.
a) Select Service → Upload Firmware.
b) Select Browse and navigate to the folder containing the HMC firmware file.
c) Select the ".cry" file, and select Open.
d) In the Upload Firmware window, select Upload to start the firmware upgrade.

7. When upload is finished, select Tools → Diagnostics.
8. Select Device Errors and check for “Checksum”.
9. If “Checksum” is on the list, then do the following:

a) Select Tools → Factory Settings.
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b) Select All and then select OK.

c) Select Yes.
Note
An error message might be displayed when performing the Reset to Factory
Settings operation. The operation has been successful if the checksum error
has been cleared.

10. Select Tools → Restart Device.
11. Select Tools → Diagnostics, and then select Device Errors to verify that the

“Checksum” error is no longer present.
12. If the “Checksum” error is still present, then do the following:

a) Select Service → View Holding Registers.
b) Select Numbers.
c) In the Start Register box, type 65510, and then select Read.
d) Type the value 16760 for register 65510 and select Store.

13. Select Tools → Restart Device.
14. If the HMC is configured for Modbus ASCII or Levelmaster communication, then

proceed with the following:
a) Close Rosemount Radar Master and disconnect the RS-485 converter from the

HMC.
b) Cycle the power to the HMC to exit the Modbus RTU communication mode.
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7.5  Application challenges
7.5.1  Handling disturbances at top of tank

Trim Near Zone function
The Trim Near Zone function is used to fine tune performance in the area close to the
tank top (Near Zone). The Near Zone stretches about 3.3 ft (1 m) into the tank from the
lower side of the device flange. Normally it is not necessary to use the function, but if you
experience problems related to the nozzle, pipe, or chamber installation, you may need to
use this function.
Figure 7-12 describes the Trim Near Zone function and its effect on the echo curve. This
effect is only visible if measurement conditions so require.

Figure 7-12: Echo Curve Before and After Trim Near Zone

A. Reference Peak
B. Trim Near Zone
C. 0-3.3 ft (0-1 m)

Perform trim near zone
The Trim Near Zone function is used to fine tune performance in the area close to the tank
top (Near Zone).
Prerequisites
Before performing the Trim Near Zone, ensure that:
• There is product in the tank.
• The product level is below the Near Zone region (0-3.3 ft (0-1 m) below the Upper

Reference Point).
Note
The Trim Near Zone function should only be used for reducing impact from stationary
disturbances. It is not suitable for occasional disturbances.

Procedure
1. Start RCT.
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2. Select the Device Commands option from the View menu.
3. Open the Details folder.
4. Select the Trim Near Zone option.
5. Select the Update option and click OK.

Reset trim near zone
To reset the Trim Near Zone function to factory settings:
Procedure

1. Start RCT.
2. Select the Device Commands option from the View menu.
3. Open the Details folder.
4. Select the Trim Near Zone option.
5. Select the Reset to Factory Settings option and click OK.

Change the upper null zone
Procedure

1. Start the Radar Configuration Tool (RCT).
2. Identify desired Upper Null Zone using the Waveform Plot.

a) Start the Waveform Plot reading.
b) View the Waveform Plot to find out if there are disturbing echoes close to the

tank top.

3. Set the desired Upper Null Zone value.
a) Select the Setup icon in the RCT workspace project bar.
b) Select the Probe tab in the Setup window.
c) Select the Receive Page button.
d) Type the desired value in the Upper Null Zone field.
e) Select the Send Page button.

Now the UNZ is stored in the transmitter memory.

Related information
Upper null zone

7.5.2  Interface level with submerged probe
The measurement mode Interface when Immersed Probe is used to handle interface
measurements when the product level is not visible, for example in a full chamber pipe as
illustrated in Figure 7-13. In this case the probe is fully submerged into the upper product,
and only the interface level is detected by the transmitter.
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Figure 7-13: Interface Level Measurements in a Full Chamber

A
C

D

B

A. Interface distance
B. Interface level
C. Product level is ignored
D. Interface level is measured

Even if the upper product level drops, it is ignored by the transmitter which continues to
measure only the interface level. If the product level drops, the air filled region in the upper
part of the pipe will slightly reduce the measurement accuracy of the interface level. To
achieve high accuracy in this measurement mode the probe must be fully submerged.

Set the measurement mode
To set the measurement mode to Interface when Immersed Probe:
Prerequisites
Note
Do not use Measurement Mode Interface when Immersed Probe in “standard” applications
when both interface level and product level are measured.

Procedure
1. In RCT, open the Setup window.
2. Select the Environment tab.
3. Select Interface when Immersed Probe measurement mode.
4. Select the Send Page button.

Need help?
Adjust Threshold T2 if the level pulse is not detected.
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7.6  Replace the transmitter head
Figure 7-14: Transmitter Head Replacement

E

B

F

CD

B

A

CD

A. Flanged version
B. Nut
C. Process seal
D. Put the protection plug here
E. Threaded version
F. Adapter

Prerequisites
Note
If the transmitter head must be removed from the probe, ensure that the process seal is
carefully protected from dust and water.

Procedure
1. Loosen the nut that connects the transmitter head to the process seal.
2.  Carefully lift the transmitter head.
3. On the probe, ensure that the upper surface of the process seal is clean and free

from dust and water. Wipe it clean with a dry and lint-free cloth.
4. Verify the spring-loaded pin at the center of the process seal is properly inserted.

When inserted properly, only the plunger is seen above the edge inside the seal
hole.
Note
Do not remove the process seal from the adapter.
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5. If the transmitter head is not mounted directly, attach the protection plug to the
process seal to protect the exposed parts from dust and water. If a protection plug
is not available, then cover the process seal with a plastic bag.

6. Rotate the new transmitter head so the device display faces the desired direction.
7. Tighten the nut. Max torque is 30 ft-lb (40 Nm).

Postrequisites
Configure the transmitter.

7.7  Replace the probe
Figure 7-15: Probe Replacement

F

C

E

D

C

B B

A

E

D

A. Flange version
B. Transmitter head
C. Nut
D. Process seal
E. Probe
F. Threaded version

Prerequisites
Flexible and rigid probes require different radar electronics and cannot be used with the
same transmitter head.
Procedure

1. Loosen the nut.
2.  Remove the transmitter head from the old probe. Be sure to protect the

transmitter head bottom from dust and water.
3. On the new probe, ensure that the protection plug is removed and the upper

surface of the process seal is clean. Also verify that the spring-loaded pin at the
center of the process seal is properly inserted.

4. Mount the transmitter head on the new probe.
5. Tighten the nut. Max torque is 30 ft-lb (40 Nm).
6. If the new probe is not of the same type as the old one, update the transmitter

configuration by setting the Probe Type parameter to the appropriate value.
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a) In RCT, select Setup → Tank Config.
b) In the Probe Type list, select desired probe type.

7. Measure the Probe Length and enter the measured value.
a) In RCT, select Setup → Tank Config.
b) In the Probe Length box, enter the measured Probe Length value.

8. Verify that the transmitter is calibrated.

7.8  Service support
To expedite the return process, refer to Emerson.com and contact the nearest Emerson
representative.

 CAUTION
Individuals who handle products exposed to a hazardous substance can avoid injury if they
are informed of and understand the hazard. Returned products must include a copy of the
required Safety Data Sheet (SDS) for each substance.

Emerson representatives will explain the additional information and procedures necessary
to return goods exposed to hazardous substances.
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A  Specifications and reference data
A.1  Performance specifications
A.1.1  General

Reference conditions
Twin Lead probe, 77 °F (25 °C) water

Reference accuracy
± 0.2 in. (5 mm) for probes ≤16.4 ft. (5 m)
± 0.1% of measured distance for rigid probes >16.4 ft. (5 m)
± 0.15% of measured distance for flexible probes >16.4 ft. (5 m)
For probes with spacers, the accuracy may deviate close to the spacers. Accuracy may be
affected by remote housing.

Repeatability
± 0.04 in. (1 mm)(1)

Ambient temperature effect
Less than 0.01% of measured distance per °C

Update interval
Minimum 1 update per second

A.1.2  Environment
Vibration resistance
• Polyurethane-covered aluminum housing: IEC 60770-1
• SST housing: IACS E10

Electromagnetic compatibility
Emission and Immunity: meets EN 61326-1:2013, class A equipment intended for use in
industrial locations if installed in metallic vessels or still-pipes.
When rigid/flexible single and twin lead probes are installed in non-metallic or open
vessels, influence of strong electromagnetic fields might affect measurements.
Related information
Installation in non-metallic tanks and open-air applications

(1) In accordance with IEC 60770-1. See the IEC 60770-1 standard for a definition of radar specific performance
parameters and if applicable corresponding test procedures.
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CE-mark
The 4–20 mA HART version (Output Option Code H) complies with applicable directives
(EMC and ATEX).

Built-in lightning protection
Meets EN 61000-4-4 Severity Level 4 and EN 61000-4-5 Severity Level 4

Contamination/product build-up
• Single lead probes are preferred when there is a risk of contamination (because build-

up can result in the product bridging across the two leads for twin versions; between
the inner lead and outer pipe for the coaxial probe).

• For viscous or sticky applications, PTFE probes are recommended. Periodic cleaning
may also be required.

• For viscous or sticky applications, it is not recommended to use centering discs
mounted along the single lead probe.

• Maximum error due to coating is 1 to 10% depending on probe type, dielectric
constant, coating thickness, and coating height above product surface.

Table A-1: Maximum Recommended Viscosity and Contamination/Build-up
Probe type Maximum viscosity Contamination/build-up
Single lead 8000 cP(1) Build-up allowed
Twin lead 1500 cP Thin build-up allowed, but no

bridging
Coaxial 500 cP Not recommended

(1) Consult your local Emerson representative in the case of agitation/turbulence and high
viscous products.

A.1.3  Measuring range
Measuring range and minimum dielectric constant
See Table A-2 and Table A-3 for each probe’s measuring range and minimum dielectric
constant. Due to the measuring range depending on the application and factors described
below, the values are a guideline for clean liquids. For more information, ask your local
Emerson representative.
Note
See Table A-4 for the measuring range when using the Remote Housing.
Different parameters (factors) affect the echo and therefore the maximum measuring
range differs depending on application according to:
• Disturbing objects close to the probe.
• Media with higher dielectric constant (εr) gives better reflection and allows a longer

measuring range.
• Surface foam and particles in the tank atmosphere may affect measuring performance.
• Heavy product build-up or contamination on the probe should be avoided since it can

reduce measuring range and might cause erroneous level readings.
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Table A-2: Maximum Measuring Range
Probe type Maximum measuring range
Rigid single lead/segmented rigid
single lead

9 ft. 10 in. (3 m) for 8 mm probes (code 4A)
19 ft. 8 in. (6 m) for 13 mm probes (code 4B)
19 ft. 8 in. (6 m) for 13 mm probes (code 4S)

Flexible single lead 77 ft. 1 in. (23.5 m)
Coaxial 19 ft. 8 in. (6 m)
Rigid twin lead 9 ft. 10 in. (3 m)
Flexible twin lead 77 ft. 1 in. (23.5 m)

Table A-3: Minimum Dielectric Constant
Probe type Minimum dielectric constant
Rigid single lead/segmented rigid
single lead

2.5(1)

(1.7 if installed in a metallic bypass or stilling well)
Flexible single lead 2.5 up to 36 ft. (11 m)(2)

5.0 up to 66 ft. (20 m)
7.5 up to 77 ft. 1 in. (23.5 m)

Coaxial 1.5
Rigid twin lead 1.9
Flexible twin lead 1.6 up to 33 ft. (10 m)

2.0 up to 66 ft. (20 m)
2.4 up to 77 ft. 1 in. (23.5 m)

(1) May be lower depending on installation.
(2) In pipes with a diameter less than 8 in. (20 cm), the minimum dielectric constant is 2.0.
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Table A-4: Measuring Range and Minimum Dielectric Constant when using Remote
Housing

Rigid single
lead/
segmented
rigid single
lead

Flexible single
lead

Coaxial Rigid twin
lead

Flexible twin lead

Maximum
measuring
range

9 ft. 10 in. (3
m) for 8 mm
probes
14 ft. 9 in. (4.5
m) for 13 mm
probes

77 ft. 1 in. (23.5
m)

19 ft. 8 in.
(6 m)

9 ft. 10 in. (3
m)

77 ft. 1 in. (23.5 m)

Minimum
dielectric
constant with
1 m remote
housing

2.7(1)

(2.0 if installed
in a metallic
bypass or
stilling well)

2.7 up to 36 ft.
(11 m)
6 up to 66 ft. (20
m)
10 up to 72 ft. (22
m)

1.5 2.1 1.7 up to 33 ft. (10
m)
2.2 up to 66 ft. (20
m)
2.6 up to 72 ft. (22
m)

Minimum
dielectric
constant with
2 m remote
housing

3.3(1)

(2.2 if installed
in a metallic
bypass or
stilling well)

3.2 up to 36 ft.
(11 m)
8 up to 67 ft.
(20.5 m)

1.6 2.5 1.8 up to 33 ft. (10
m)
2.4 up to 67 ft.
(20.5 m)

Minimum
dielectric
constant with
3 m remote
housing

3.8(1)

(2.5 if installed
in a metallic
bypass or
stilling well)

3.7 up to 36 ft.
(11 m)
11 up to 62 ft. (19
m)

1.7 2.8 2.0 up to 33 ft. (10
m)
2.7 up to 62 ft. (19
m)

(1) May be lower depending on installation.

Interface measuring range
The maximum allowable upper product thickness/measuring range is primarily
determined by the dielectric constants of the two liquids.
Typical applications include interfaces between oil/oil-like and water/water-like liquids, with
a low (<3) dielectric constant for the upper product and a high (>20) dielectric constant for
the lower product. For such applications, the maximum measuring range is limited by the
length of the coaxial, rigid twin, and rigid single lead probes.
For the flexible twin lead probe, the maximum measuring range will be reduced
depending on the maximum upper product thickness according to Figure A-1. However,
characteristics vary between different applications. For other product combinations,
consult your local Emerson representative.
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Figure A-1: Interface Level Measurement

0 (0) 3.3 (1)
65.6 (20)

68.9 (21)

72.2 (22)

75.5 (23)

78.7 (24)

 82.0 (25)

2
3
5

6.6 (2) 9.8 (3) 13.1 (4) 16.4 (5)

A

B

C
D

A. Maximum measuring range, ft. (m)
B. Maximum upper product thickness, ft. (m)
C. Upper product dielectric constant
D. Example: If the upper product dielectric constant is 2, and the upper product thickness is

5 ft. (1.5 m), the maximum measuring range is 75.5 ft. (23 m).

Transition zones
These zones are areas where measurements are non-linear or have reduced accuracy. If
measurements are desired at the very top of a tank, it is possible to mechanically extend
the nozzle and use a coaxial probe. The upper transition zone is then moved into the
extension. See Table A-5.
For a flexible single lead probe with chuck, the lower transition zone is measured upwards
from the upper part of the clamp.

Figure A-2: Transition Zones

A
B

C

D

D D

E

A. Upper Reference Point
B. Upper Transition Zone
C. Maximum Recommended Measuring Range
D. Lower Transition Zone
E. Lower Reference Point
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Table A-5: Transition Zones
Dielectric
Constant

Rigid single lead/
segmented rigid
single lead

Flexible single
lead

Coaxial Rigid twin lead Flexible twin
lead

Upper
Transition
Zone(1)

80 4 in. (10 cm) 5.9 in. (15 cm) 4 in. (10 cm) 4 in. (10 cm) 5.9 in. (15 cm)
2 4 in. (10 cm) 20 in. (50 cm) 4 in. (10 cm) 4 in. (10 cm) 8 in. (20 cm)

Lower
Transition
Zone(2)

80 2 in. (5 cm) 2 in. (5 cm)(3)(4) 1.2 in. (3 cm) 2 in. (5 cm) 2 in. (5 cm)(4)

2 4 in. (10 cm) 6.3 in. (16 cm)
- long weight,
short weight, and
chuck(4)(5)

2 in. (5 cm) 2.8 in. (7 cm) 5.9 in. (15 cm)(4)(5)

(1) The distance from the upper reference point where measurements have reduced accuracy.
(2) The distance from the lower reference point where measurements have reduced accuracy.
(3) The measuring range for the PTFE covered Flexible Single Lead probe includes the weight when measuring

on a high dielectric media.
(4) Note that the weight length or chuck fastening length adds to non-measurable area and is not included in

the diagram.
(5) When using a metallic centering disc, the lower transition zone is 8 in. (20 cm), including weight if

applicable. When using a PTFE centering disc, the lower transition zone is not affected.

Note
The 4–20 mA set points are recommended to be configured between the transition zones,
within the measuring range.

A.2  Functional specifications
A.2.1  General

Field of application
Liquids and semi-liquids level or liquid/liquid interfaces
• Model 3301, for level or submerged probe interface measurement
• Model 3302, for level and interface measurements

Measurement principle
Time Domain Reflectometry (TDR)

Microwave output power
Nominal 50 μW, Max. 2 mW

EMC
FCC part 15 subpart B and EMC Directive (2014/30/EU). Considered to be an unintentional
radiator under the Part 15 rules.

Humidity
0 to 100% relative humidity
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Start-up time
< 10 s

A.2.2  4-20 mA HART®

Output
Two-wire, 4-20 mA. Digital process variable is superimposed on 4-20 mA signal, and
available to any host that conforms to the HART protocol. The digital HART® signal can
be used in multidrop mode.

Emerson Wireless 775 THUM™ Adapter
The optional Emerson Wireless 775 THUM Adapter can be mounted directly on the
transmitter or by using a remote mounting kit.

IEC 62591 (WirelessHART®) enables access to multivariable data and diagnostics, and adds
wireless to almost any measurement point.
See the Emerson Wireless 775 THUM Adapter Product Data Sheet and Technical Note for
additional information.

Power requirements
Terminals in the transmitter housing provide connections for signal cables. The Rosemount
3300 Level Transmitter is loop-powered and operates with the following power supplies:
Table A-6: External Power Supply for HART
Approval type Input voltage (Ui)(1)

None 11 - 42 Vdc
Intrinsically Safe 11 - 30 Vdc
Explosion-proof/Flameproof 16 - 42 Vdc

(1) Reverse polarity protection.
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Figure A-3: External Power Supply for HART

UI

R
UE

R = Load Resistance (Ω)
UE = External Power Supply Voltage (Vdc)
Ui = Input Voltage (Vdc)

For Flameproof/Explosion-proof installations the Rosemount 3300 Series transmitters have
a built-in barrier; no external barrier needed.
When the Emerson Wireless 775 THUM™ Adapter is fitted, it adds a maximum drop of 2.5
Vdc in the connected loop.

Signal on alarm
  High Low
Standard 21.75 mA 3.75 mA
Namur NE43 22.50 mA 3.60 mA

Saturation levels
  High Low
Standard 20.8 mA 3.9 mA
Namur NE43 20.5 mA 3.8 mA
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Load limitations
For HART® communication, a minimum loop resistance of 250 Ω is required. Maximum loop
resistance is determined by the voltage level of the external power supply, as given by the
following diagrams:

Figure A-4: Non-Hazardous Installations

C

B

A

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)
C. Operating region

Figure A-5: Intrinsically Safe Installations

C

B

A

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)
C. Operating region
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Figure A-6: Explosion-proof/Flameproof Installations

C

B

A

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)
C. Operating region

Note
For the Explosion-proof/Flameproof installations the diagram is only valid if the HART load
resistance is at the + side, otherwise the load resistance value is limited to 300 Ω.

A.2.3  Modbus®

Output
The RS-485 Modbus version communicates by Modbus RTU, Modbus ASCII, and
Levelmaster protocols.
8 data bits, 1 start bit, 1 stop bit, and software selectable parity.
Baud Rate 1200, 2400, 4800, 9600 (default), and 19200 bits/s
Address Range 1 to 255 (default device address is 246)

HART communication is used for configuration via the HART terminals or tunneling via the
RS-485.

External power supply
The input voltage Ui for Modbus is 8-30 Vdc (max. rating).
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Figure A-7: External Power Supply for Modbus

UI

RS485 bus

Ui = Input Voltage (Vdc)

For Flameproof/Explosion-proof installations the Rosemount 3300 Series transmitters have
a built-in barrier; no external barrier needed.

Power consumption
• < 0.5 W (with HART address=1)
• < 1.2 W (incl. four HART slaves)

A.2.4  Display and configuration
Integral display
The integral digital display can toggle between: level, distance, volume, internal
temperature, interface distance, interface level, peak amplitudes, interface thickness,
percentage of range, analog current out.
Note
The display cannot be used for configuration purposes.

Remote display
Data can be read remotely by using the Rosemount 751 Field Signal Indicator, see the
corresponding Product Data Sheet for more information.

Configuration tools
• Rosemount Radar Configuration Tool (included in the delivery)
• Device Descriptor (DD) based systems, e.g. AMS Device Manager, handheld

communicator, and DeltaV™

• Device Type Manager (DTM™) based systems (compliant with version 1.2 of the
FDT®/DTM specification), supporting configuration in for instance Yokogawa Fieldmate/
PRM, E+H FieldCare®, and PACTware™
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Output units
• Level, Interface and Distance: ft., in., m, cm, or mm
• Volume: ft.3, in.3, US gals, Imp gals, barrels, yd3, m3, or liters

Output variables
Table A-7: Output Variables
Variable  3301 3302
Level ✓ ✓

Distance (to product surface) ✓ ✓

Volume ✓ ✓

Internal Temperature ✓ ✓

Interface Level (✓)(1) ✓

Interface Distance (✓)(1) ✓

Upper Product Thickness N/A ✓

Peak Amplitudes ✓ ✓

(1) Interface measurement only for fully submerged probe.

Damping
0-60 s (10 s, default value)
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A.2.5  Process temperature and pressure rating
Figure A-8 gives the maximum process temperature (measured at the lower part of the
flange or threaded connection) and pressure rating.

Final rating depends on flange, material of construction, and O-ring selection.

Figure A-8: Maximum Rating, Standard Tank Connections

C
302

(150)
-40

(-40)

-15 (-1)

580 (40)

232 (16)

A

B

A. Pressure psig (bar)
B. Temperature °F (°C)
C. Protective plate: PTFE (Material of construction code 7)

Table A-8: Temperature and Pressure Ranges for Standard Tank Seals with Different
O-ring Material
O-ring material Temperature °F (°C) in air Pressure psig (bar)

Minimum Maximum Maximum
Fluoroelastomer (FKM) -22 (-30) 302 (150) 580 (40)
Ethylene Propylene (EPDM) -40 (-40) 266 (130) 580 (40)
Kalrez® Perfluoroelastomer
(FFKM)

14 (-10) 302 (150) 580 (40)

Nitrile Butadiene (NBR) -31 (-35) 230 (110) 580 (40)

Note
Always check the chemical compatibility of the O-ring material with your application. If the
O-ring material is not compatible with its chemical environment, the O-ring may eventually
malfunction.
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A.2.6  Temperature limits
Ambient temperature
The maximum and minimum ambient temperature for the electronics depends the
approval.
Note
In applications where the ambient temperature exceeds the limits of the electronics, a
Remote Mounting connection can be used. The maximum temperature for the Remote
Mounting connection at the vessel connection point is 302 °F (150 °C).
Table A-9: Ambient Temperature Limits
Description Operating limit Storage limit
Without integral display -40 °F to 185 °F (-40 °C to 85 °C) -40 °F to 176 °F (-40 °C to 80 °C)
With integral display -40 °F to 158 °F (-40 °C to 70 °C)(1) -40 °F to 176 °F (-40 °C to 80 °C)

(1) Integral display may not be readable and device display updates will be slower at
temperatures below -4 °F (-20 °C).

Related information
Product certifications

A.2.7  Flange rating
ASME flange rating
316 according to ASME B16.5 Table 2-2.2:
• Maximum 302 °F/580 psig (150 °C/40 bar)
Alloy C-276 (UNS N10276) according to ASME B16.5 Table 2-3.8:
• Maximum 302 °F/580 psig (150 °C/40 Bar)
EN flange rating
EN 1.4404 according to EN 1092-1 material group 13E0:
• Maximum 302 °F/580 psig (150 °C/40 Bar)
Alloy C-276 (UNS N10276) according to EN 1092-1 material group 12E0:
• Maximum 302 °F/580 psig (150 °C/40 Bar)
JIS flange rating
316 according to JIS B2220 material group 2.2:
• Maximum 302 °F/580 psig (150 °C/40 Bar)
Fisher and Masoneilan flange rating
316 according to ASME B16.5 Table 2-2.2:
• Maximum 302 °F/580 psig (150 °C/40 Bar)
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A.2.8  Tri Clamp rating
Table A-10: Tri Clamp Rating
Size Maximum pressure(1)

1½-in. (37.5 mm) 232 psig (16 bar)
2-in. (50 mm) 232 psig (16 bar)
3-in. (75 mm) 145 psig (10 bar)
4-in. (100 mm) 145 psig (10 bar)

(1) The final rating depends on the clamp and gasket.

A.2.9  Plate design
Certain models of flanged alloy and PTFE covered probes have a tank connection design
with a protective flange plate that prevents the backing flange from being exposed to the
tank atmosphere. The protective flange plate is manufactured in the same material as the
probe. The backing flange is made of 316L/EN 1.4404 for alloy probes, and 316/1.4404 for
PTFE covered probes.

Figure A-9: Protective Plate

A. Alloy probe and protective plate
B. PTFE covered probe and protective plate
C. Protective plate

PTFE protective plate
Flange rating according to SST backing flange ASME B16.5 Table 2-2.2, EN 1092-1 material
group 13E0, and JIS B2220 material group 2.3.
• Maximum 302 °F/232 psig (150 °C/16 Bar)
Alloy C-276 protective plate
Flange rating according to SST backing flange ASME B16.5 Table 2-2.3, EN 1092-1 material
group 13E0, and JIS B2220 material group 2.3.
• Maximum 302 °F/580 psig (150 °C/40 Bar)
Alloy 400 protective plate
Flange rating according to SST backing flange ASME B16.5 Table 2-2.3, EN 1092-1 material
group 13E0, and JIS B2220 material group 2.3.
• Maximum 302 °F/580 psig (150 °C/40 Bar)
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A.2.10  Conditions used for flange strength calculations
Table A-11: 316/316L Flanges
Standard Bolting material Gasket Flange material Hub material
ASME Stainless steel SA193

B8M Cl.2
Soft (1a) with min.
thickness 1.6 mm

Stainless steel A182
Gr. F316

Stainless steel SA479M
316

EN, JIS EN 1515-1/-2 group
13E0, A4-70

Soft (EN 1514-1) with
min. thickness 1.6 mm

Stainless steel A182
Gr. F316 and EN
10222-5-1.4404

Stainless steel SA479M
316, and EN
10272-1.4404

Table A-12: Process Connection with Plate Design
Standard Bolting material  Gasket Flange material  Hub material 
ASME Stainless steel SA193

B8M Cl.2
Soft (1a) with min.
thickness 1.6 mm

Stainless steel A182
Gr. F316L/F316

SB574 Gr. N10276 or
SB164 Gr. N04400

EN, JIS EN 1515-1/-2 group
13E0, A4-70

Soft (EN 1514-1) with
min. thickness 1.6 mm

Stainless steel A182
Gr. F316L/F316 and EN
10222-5-1.4404

Table A-13: Alloy C-276 Flanges
Standard Bolting material Gasket Flange material Hub material
ASME UNS N10276 Soft (1a) with min.

thickness 1.6 mm
SB462 Gr. N10276
(solution annealed
condition) or SB575
Gr. N10276 (solution
annealed condition)

SB574 Gr. N10276

EN, JIS Soft (EN 1514-1) with
min. thickness 1.6
mm

A.2.11  Interface measurements
The Rosemount 3302 is a good choice for measuring the interface of oil and water, or other
liquids with significant dielectric differences. It is also possible to measure interfaces with a
Rosemount 3301 in applications where the probe is fully submerged in the liquid.

Figure A-10: Interface Level Measurement
A

C

D

D

B

A. Rosemount 3302
B. Rosemount 3301 (fully submerged)
C. Product level
D. Interface level
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Interface measurement considerations
If interface is to be measured, follow these criteria:
• The dielectric constant of the upper product should be known and should not vary. The

Radar Configuration Tools software has a built-in dielectric constant calculator to assist
the user in determining the dielectric constant of the upper product.

• The dielectric constant of the upper product must have a lower dielectric constant than
the lower product to have a distinct reflection.

• The difference between the dielectric constants for the two products must be larger
than 10.

• Maximum dielectric constant for the upper product is 10 for the coaxial probe, and 5 for
twin lead probes.

• The upper product thickness must be larger than 8 in. (0.2 m) for the flexible twin lead
probe; 4 in. (0.1 m) for the rigid twin lead, and coaxial probes in order to distinguish the
echoes of the two liquids.

Emulsion layers
Sometimes there is an emulsion layer (mix of the products) between the two products
which can affect interface measurements. For guidelines on emulsion situations, consult
your local Emerson representative.

A.3  Physical specifications
A.3.1  Material selection

Emerson provides a variety of Rosemount products with various product options and
configurations, including materials of construction that can be expected to perform well
in a wide range of applications. The Rosemount product information presented is intended
as a guide for the purchaser to make an appropriate selection for the application. It is the
purchaser’s sole responsibility to make a careful analysis of all process parameters (such
as all chemical components, temperature, pressure, flow rate, abrasives, contaminants,
etc.), when specifying product, materials, options, and components for the particular
application. Emerson is not in a position to evaluate or guarantee the compatibility of
the process fluid or other process parameters with the product, options, configuration, or
materials of construction selected.

A.3.2  Engineered solutions
When standard model codes are not sufficient to fulfill requirements, please consult the
factory to explore possible Engineered Solutions. This is typically, but not exclusively,
related to the choice of wetted materials or the design of a process connection. These
Engineered Solutions are part of the expanded offerings and may be subject to additional
delivery lead time. For ordering, factory will supply a special R-labeled numeric option code
that should be added at the end of the standard model string.
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A.3.3  Housing and enclosure
Type
Dual compartment (removable without opening the tank). Electronics and cabling are
separated. Two entries for conduit or cable connections. The transmitter housing can be
rotated in any direction.
Electrical connection
½ - 14 NPT for cable glands or conduit entries.
Optional: M20 x 1.5 conduit/cable adapter or PG 13.5 conduit/cable adapter.
Recommended output cabling is twisted shielded pairs, 18-12 AWG.
Housing material
Polyurethane-covered Aluminum or SST Grade CF8M (ASTM A743)
Ingress protection
NEMA® 4X, IP 66, IP 67
Factory sealed
Yes
Weight
• Aluminum transmitter head: 5.5 lb (2.5 kg)
• SST transmitter head: 11 lb (5 kg)

A.3.4  Remote housing mounting
Kit that includes a flexible armored extension cable and a bracket for wall or pipe
mounting.

Figure A-11: Remote Housing Mounting

A

A. Remote Housing Mounting Cable: 3, 6, or 9 ft (1, 2, or 3 m)

A.3.5  Tank connection
The tank connection consists of a tank seal, a flange, Tri Clamp, or NPT or BSPP (G) threads.
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A.3.6  Flange dimensions
Follows ASME B16.5, JIS B2220, and EN 1092-1 standards for blind flanges.

A.3.7  Vented flanges
Available with Masoneilan and Fisher vented flanges. Vented flanges must be ordered
as accessories with a 1½-in. NPT threaded process connection (code RA); see Proprietary
flanges. As an alternative to a vented flange, it is possible to use a flushing connection ring
on top of the standard nozzle.

A.3.8  Tri Clamp connection
Follows ISO 2852 standard.

A.3.9  Pressure Equipment Directive (PED)
Complies with 2014/68/EU article 4.3

A.3.10  Probes
Probe versions
Coaxial, rigid twin and rigid single lead, flexible twin and flexible single lead.
For interface measurements, rigid single probe is the best choice for chamber mounting.
The twin or coaxial probe is the preferred choice for clean, low dielectric constant liquids.
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Total probe length
This is defined from the Upper Reference Point to the end of the probe (weight included, if
applicable).

Figure A-12: Total Probe Length

A. NPT
B. BSPP (G)
C. Flange
D. Tri Clamp
E. Upper reference point
F. Total probe length

Select the probe length according to the required measuring range (the probe must be
hung and fully extended through the entire distance where level readings are desired).

Cut-to-fit probes
All probes can be cut in field except for the PTFE covered probe.
However, there are some restrictions for the coaxial probe: Probes over 4.1 ft. (1.25 m) can
be cut up to 2 ft. (0.6 m). Shorter probes can be cut to the minimum length of 1.3 ft. (0.4 m).

Minimum and maximum probe length
Probe type Probe length
Flexible single lead 3.3 to 77.1 ft. (1 to 23.5 m)
Rigid single lead (0.3 in./8 mm) 1.3 to 9.8 ft. (0.4 to 3 m)
Rigid single lead (0.5 in./13 mm) 1.3 to 19.7 ft. (0.4 to 6 m)
Segmented rigid single lead 1.3 to 19.7 ft. (0.4 to 6 m)
Flexible twin lead 3.3 to 77.1 ft. (1 to 23.5 m)
Rigid twin lead 1.3 to 9.8 ft. (0.4 to 3 m)
Coaxial 1.3 to 19.7 ft. (0.4 to 6 m)
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Probe angle
0 to 90 degrees from vertical axis

Tensile strength
• 0.16 in. (4 mm) Flexible single lead SST: 2698 lb (12 kN)
• 0.16 in. (4 mm) Flexible single lead Alloy C-276: 1574 lb (7 kN)
• 0.16 in. (4 mm) Flexible single lead Alloy 400: 1124 lb (5 kN)
• Flexible twin lead SST: 2023 lb (9 kN)

Collapse load
• 0.16 in. (4 mm) Flexible single lead SST: 3597 lb (16 kN)
• 0.16 in. (4 mm) Flexible single lead Alloy C-276: 1798 lb (8 kN)
• 0.16 in. (4 mm) Flexible single lead Alloy 400: 1349 lb (6 kN)

Sideway capacity
• Rigid single lead/Segmented rigid single lead: 4.4 ft. lbf, 0.44 lb at 9.8 ft. (6 Nm, 0.2 kg at

3 m)
• Rigid twin lead: 2.2 ft. lbf, 0.22 lb at 9.8 ft. (3 Nm, 0.1 kg at 3 m)
• Coaxial: 73.7 ft. lbf, 3.7 lb at 19.7 ft. (100 Nm, 1.67 kg at 6 m)

A.3.11  Material exposed to tank atmosphere
Table A-14: Standard Probe (Operating Temperature and Pressure Code S)
Material of construction code Material exposed to tank atmosphere
1 316L/316 (EN 1.4404), PTFE, PFA, silicone grease, and O-ring

materials
2 Alloy C-276 (UNS N10276), PTFE, PFA, silicone grease, and O-ring

materials
3 Alloy 400 (UNS N04400), Alloy K500 (UNS N05500), PTFE, PFA,

silicone grease, and O-ring materials
7 PTFE (1 mm PTFE cover)
8 316L/316 (EN 1.4404), PTFE, silicone grease, and O-ring materials
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A.3.12  Weight
Table A-15: Flange and Probes
Item Weight
Flange Depends on flange size
Flexible single lead probe 0.05 lb/ft. (0.08 kg/m)
Rigid single lead probe (0.3-in./8 mm) 0.27 lb/ft. (0.4 kg/m)
Rigid single lead probe (0.5-in./13 mm) 0.71 lb/ft. (1.06 kg/m)
Segmented rigid single lead probe 0.71 lb/ft. (1.06 kg/m)
Flexible twin lead probe 0.09 lb/ft. (0.14 kg/m)
Rigid twin lead probe 0.40 lb/ft. (0.6 kg/m)
Coaxial probe 0.67 lb/ft. (1 kg/m)

Table A-16: End Weight
Item Weight
Standard weight for flexible single lead probe (0.16-
in./4 mm)

0.88 lb (0.40 kg)

Short weight (W2) for flexible single lead probe (0.16-
in./4 mm)

0.88 lb (0.40 kg)

Heavy weight (W3) for flexible single lead probe (0.16-
in./4 mm)

2.43 lb (1.10 kg)

Weight for PTFE covered flexible single lead 2.2 lb (1 kg)
Weight for twin lead probe 1.3 lb (0.60 kg)

A.3.13  End weight options
A short weight is available for the single flexible probe. It is used for measuring close to the
probe end and shall be used where the measuring range must be maximized. The height is
2 in. (50 mm) and the diameter is 1.5 in. (37.5 mm). The option code is W2.
If a heavier weight is needed, option code W3 can be used. The height is 5.5 in. (140 mm)
and the diameter is 1.5 in. (37.5 mm).
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A.4  Dimensional drawings
Figure A-13: Rigid Single Lead Probe with Flange Connection

6.8 (173)

B

4.3 (110) 4.1 (104)

4.5 (113)

9.5 (241)

C

C

A

A. L ≤ 10 ft. (3 m); L ≤ 20 ft. (6 m) for Ø 0.51 (13)
B. Ø 0.31 (8) or Ø 0.51 (13) for SST and Alloy probes; Ø 0.47 (12) for PTFE covered probe
C. The PTFE and alloy probes are designed with a protective plate.

Dimensions are in inches (millimeters).
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Figure A-14: Rigid Single Lead Probe with Threaded Connection

6.8 (173)

C

E

6.8 (173)

4.3 (110) 4.3 (110) 4.1 (104)

4.5 (113)

9.5 (241)9.5 (241)

1.1 (27)
2.4 (62)

B B

D

E

F F

G

A

A. G 1/1½ inch
B. NPT 1/1½/2 inch
C. ½ - 14 NPT; optional adapters: M20x1.5
D. s52/s60
E. L ≤ 10 ft. (3 m); L ≤ 20 ft. (6 m) for Ø 0.51 (13)
F. Ø 0.31 (8) or Ø 0.51 (13) for SST and Alloy probes; Ø 0.47 (12) for PTFE covered probe
G. s52

Dimensions are in inches (millimeters).
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Figure A-15: Segmented Rigid Single Lead Probe with Flange Connection
6.8 (173)

4.3 (110) 4.1 (104)

4.5 (113)

9.5 (241)

B

0.6 (15)

15.2 (385)

31.5 (800)

A

Ø 0.51 (13)

C

D

A. ½ - 14 NPT; optional adapters: M20x1.5
B. L ≤ 20 ft. (6 m)
C. Optional: PTFE centering disc
D. Optional: Bottom centering disc (SST or PTFE)

Dimensions are in inches (millimeters).
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Figure A-16: Segmented Rigid Single Lead Probe with Threaded Connection
6.8 (173)

C

4.3 (110) 4.1 (104)

4.5 (113)

9.5 (241)

B

D

Ø 0.51 (13)

0.6 (15)

15.2 (385)

31.5 (800)
2.

4 
(6

2)

1.
1 

(2
7)

2.4 (62)

E

F

A

A. ½ - 14 NPT; optional adapters: M20x1.5, PG 13.5
B. L ≤ 20 ft. (6 m)
C. BSP-G 1 in., s52; BSP-G 1½ in., s60
D. Optional: PTFE centering disc
E. Optional: Bottom centering disc (SST or PTFE)
F. NPT 1 in., s52; NPT 1½ in., s52; NPT 2 in., s60

Dimensions are in inches (millimeters).
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Figure A-17: Flexible Single Lead Probe with Flange Connection
6.8 (173)

4.3 (110)

9.5 (241)

B

4.1 (104)

4.5 (113)

A

C

D

E

F

G

2 (50)

5.5 (140)

Ø 1.5 (37.5) Ø 1.5 (37.5)

A. L ≤ 77 ft. (23.5 m)
B. Ø 0.16 (4) for SST probe; Ø 0.28 (7) for PTFE covered probe
C. 5.5 (140) for SST probe; 17.1 (435) for PTFE covered probe
D. Ø 0.86 (22) for SST probe; Ø 0.88 (22.5) for PTFE covered probe
E. The PTFE covered probe is designed with a protective plate.
F. Short weight (option W2)
G. Heavy weight (option W3)

Dimensions are in inches (millimeters).
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Figure A-18: Flexible Single Lead Probe with Threaded Connection

6.8 (173)

4.3 (110)

9.5 (241)
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1.1 (27)

9.5 (241)

6.8 (173)

4.3 (110)

2.4 (62)

4.1 (104)

4.5 (113)

2 (50)

5.5 (140)

BA

C

Ø 1.5 (37.5) Ø 1.5 (37.5)

D D

E

F F

G

H

I

J

K

A. G 1/1½ in.
B. NPT 1/1½/2 in.
C. ½ - 14 NPT; optional adapters: M20x1.5
D. L ≤ 77 ft. (23.5 m)
E. s52/s60
F. Ø 0.16 (4) for SST probe; Ø 0.28 (7) for PTFE covered probe
G. 5.5 (140) for SST probe; 17.1 (435) for PTFE covered probe
H. Ø 0.86 (22) for SST probe; Ø 0.88 (22.5) for PTFE covered probe
I. 1 in./1½ in.: s52; 2 in.: s60
J. Short weight (option W2)

K. Heavy weight (option W3)

Dimensions are in inches (millimeters).
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Figure A-19: Coaxial Probe with Flange Connection
6.8 (173)

4.3 (110)

9.5 (241)

4.1 (104)

4.5 (113)

1.1 (28)

B B

A

C

A. L ≤ 20 ft. (6 m)
B. For stainless steel the probe is welded to the flange.
C. The alloy probes are designed with a protective plate.

Dimensions are in inches (millimeters).
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Figure A-20: Coaxial Probe with Threaded Connection

6.8 (173)

4.3 (110)

9.5 (241)
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1.1 (27)

9.5 (241)

6.8 (173)

4.3 (110)

2.4 (62)

4.1 (104)

4.5 (113)

B

1.1 (28) 1.1 (28)

A

C

D

E
F

D

A. G 1/1½ in.
B. NPT 1/1½/2 in.
C. ½ - 14 NPT; optional adapters: M20x1.5
D. L ≤ 20 ft. (6 m)
E. s52/s60
F. 1 in./1½ in.: s52; 2 in.: s60

Dimensions are in inches (millimeters).
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Figure A-21: Rigid Twin Lead Probe with Flange Connection
6.8 (173)

4.3 (110) 4.1 (104)

4.5 (113)

9.6 (244)

Ø 0.31 (8)

Ø 0.24 (6)

1.0 (25)

A

A. L ≤ 10 ft. (3 m)

Dimensions are in inches (millimeters).
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Figure A-22: Rigid Twin Lead Probe with Threaded Connection

6.8 (173)

C

E

6.8 (173)

4.3 (110) 4.3 (110) 4.1 (104)

4.5 (113)

9.6 (244)9.6 (244)

1.1 (27) 1.8 (45)

B B

D

F

Ø 0.31 (8)

Ø 0.24 (6)

Ø 0.31 (8)

Ø 0.24 (6)

E

1.0 (25) 1.0 (25)

A

A. G 1½ inch
B. NPT 1½/2 inch
C. ½ - 14 NPT; optional adapters: M20x1.5, PG13.5
D. s60
E. L ≤ 10 ft. (3 m)
F. 1½ in.: s52; 2 in.: s60

Dimensions are in inches (millimeters).
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Figure A-23: Flexible Twin Lead Probe with Flange Connection
6.8 (173)
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A. L ≤ 10 ft. (3 m)

Dimensions are in inches (millimeters).
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Figure A-24: Flexible Twin Lead Probe with Threaded Connection

6.8 (173)
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4.3 (110) 4.3 (110) 4.1 (104)

4.5 (113)
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Ø 1.4 (35)Ø 1.4 (35)

A

A. G 1½ in.
B. NPT 1½/2 in.
C. ½ - 14 NPT; optional adapters: M20x1.5, PG13.5
D. s60
E. L ≤ 77 ft. (23.5 m)
F. 1½ in.: s52; 2 in.: s60

Dimensions are in inches (millimeters).
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Figure A-25: Bracket Mounting

5.2 (133)

A B
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E

2.24
(57)

0.35 (9)

0.87 (22)

2.76
(70)

A. Pipe mounting (vertical pipe)
B. Pipe mounting (horizontal pipe)
C. Wall mounting
D. Hole pattern for wall mounting
E. Pipe diameter: maximum 2.5 in. (64 mm)

Dimensions are in inches (millimeters).
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Figure A-26: Remote Housing

A

B
C

5.2 (133)

A. 3, 6, 9 ft. (1, 2, or 3 m)
B. Rmin: 1.4 (35)
C. Hmin: 7.3 (185)

Dimensions are in inches (millimeters).
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A.4.1  Standard flanges
Figure A-27: Flange Connection

A B C

E

D F

D

A. Forged one-piece
B. Welded construction
C. Protective plate design
D. Weld
E. Backing flange
F. Protective plate

Table A-17: Standard Flanges
Standard Face type(1) Plate surface finish, Ra

ASME B16.5 Raised face 125-250 µin
EN 1092-1 Type A flat face 3.2-12.5 µm
JIS B2220 Raised face 3.2-6.3 µm

(1) Face gasket surface is serrated per mating standard.

Table A-18: Standard Flanges, Protective Plate
Standard Face type including protective plate Plate surface finish, Ra

ASME B16.5 Raised face 3.2-6.3 µm
EN 1092-1 Raised face 3.2-6.3 µm
JIS B2220 Raised face 3.2-6.3 µm
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A.4.2  Proprietary flanges
Figure A-28: Proprietary Flanges

D: Outside diameter
B1: Flange thickness with gasket surface
B2: Flange thickness without gasket surface
F=B1-B2: Gasket surface thickness
G: Gasket surface diameter
# Bolts: Number of bolts
K: Bolt hole circle diameter

Dimensions are in inches (millimeters).

Note
Dimensions may be used to aid in the identification of installed flanges. It is not intended
for manufacturing use.

Table A-19: Dimensions of Proprietary Flanges
Special flanges(1) D B1 B2 F G # Bolts K
Fisher™ 249B/259B(2) 9.00 (228.6) 1.50 (38.2) 1.25 (31.8) 0.25 (6.4) 5.23 (132.8) 8 7.25 (184.2)
Fisher 249C(3) 5.69 (144.5) 0.94 (23.8) 1.13 (28.6) -0.19 (-4.8) 3.37 (85.7) 8 4.75 (120.65)
Masoneilan™(2) 7.51(191.0) 1.54 (39.0) 1.30 (33.0) 0.24 (6.0) 4.02 (102.0) 8 5.87 (149.0)

(1) These flanges are also available in a vented version.
(2) Flange with raised face.
(3) Flange with recessed face.

For information about flange temperature and pressure ratings, see Fisher and Masoneilan
flange rating.
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A.4.3  Flushing connection rings
Figure A-29: Flushing Connection Rings

A. Height: 0.97 in. (24.6 mm)

Table A-20: Dimensions of Flushing Connection Rings
Flushing connection
rings

Di Do DH

2-in. ANSI 2.12 (53.8) 3.62 (91.9) ¼-in. NPT
3-in. ANSI 3.60 (91.4) 5.00 (127.0) ¼-in. NPT
4-in. ANSI/DN100 3.60 (91.4) 6.20 (157.5) ¼-in. NPT
DN50 2.40 (61.0) 4.00 (102.0) ¼-in. NPT
DN80 3.60 (91.4) 5.43 (138.0) ¼-in. NPT
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B  Configuration parameters
B.1  Menu tree
Figure B-1: HART Communicator Menu Tree Corresponding to Device Revision 2

1 DEVICE SETUP

2 PV

3 AO

4 LRV

5 URV

1 Process Variables

2 Diag/Service

3 Basic Setup

4 Detailed Setup

5 Review

1 Variable mapping

2 Level

3 Distance

4 Volume

5 Internal Temp

6 Interface Dist

7 Interface Level

8 Amplitude Peak 1

- Amplitude Peak 2

- Amplitude Peak 3

- Upper Prod Thickn

1 Measurem Units

2 Geometry/Probe

3 Misc. Settings

4 Analog Output

5 Damping Value

1 Device 

Information

2 Display

3 Volume 

Geometry

4 HART

5 Advanced Service

1 Variable re-map

2 PV is

3 SV is

4 TV is

5 QV is

1 Status

2 Master Reset

3 Loop Test

4 D/A Trim

5 Scaled D/A Trim

6 PV AO

7 PV AO Alarm Type

1 Level Unit

2 Volume Unit

3 Temperature Unit

1 PV is

2 Apply values

3 Range values

4 AO values

1 Distributor

2 Model

3 Dev Id

4 Tag

5 Descriptor

6 Message

7 Date

8 Write Protect

9 Revision #’s

- Construction Details

1 Display variables

2 Display language

1 Tank Type

2 Tank Diameter

3 Tank Height

4 Strapping Table

1 Poll addr

2 Num req preamps

3 Burst mode

4 Burst option

1 Gain Control

2 Max Up Prod Tkn

3 Thresholds

4 Reset to Default

5 Calibration Offst

- Level

- Distance

- Volume

- Internal Temp

- Interface Dist

- Interface Level

- Amplitude Peak 1

- Amplitude Peak 2

- Amplitude Peak 3

- Upper Prod Thickn

1 Status Group 1

2 Status Group 2

1 Ref Height

2 Probe Length

3 Probe Type

4 Probe Angle

5 Show Lvl=0

1 Upper Null Zone

2 Vapor Dielectric

3 Product Dielectric

4 Measurement Mode 

1 Universal rev

2 Fld dev rev

3 Software rev

1 Flange Type

2 Flange Material

3 Probe

4 Barrier

1 Strap Table

2 Ver Cylinder

3 Hor Cylinder

4 Vert Bullet

5 Hor Bullet

6 Sphere

7 None

1 Entries Used

2 Max Entries

3 Lvl0

4 Vol0

5 Lvl1

6 Vol1

7 Lvl2

8 Vol2

9 Lvl3

Vol3

Lvl9

Vol9
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B.2  Setup
B.2.1  Info

Device name
Designation of the current transmitter model.

EPROM ID
Current transmitter database version.

Device type
Designates the transmitter type. 33 is used for the Rosemount 3300 Series.

Device ID
A unique identifier for each Rosemount 3300 Level Transmitter.

Hardware rev
The current revision of the transmitter electronic board.

Software rev
The current revision of the transmitter software that controls measurement,
communication, internal checks, etc.

B.2.2  Basics
Variable units
Set the measurement units for length, volume, and temperature. These units are used
wherever measurement and configuration data is presented.

Tag
Identifier of up to 8 characters for the device used by host system. The tag is typically a
reference number, location, or duty description.

Descriptor
The 16-character descriptor field can be used for any purpose.

Message
The 32-character message field can be used for any purpose, such as providing details of
the last configuration change.

B.2.3  Output
Transmitter variables
You can assign up to four transmitter variables. Typically, the Primary Variable (PV) is
configured to be Product Level, Interface Level, or Volume.
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Other variables like Product Distance, Interface Distance, Upper Product Thickness, etc. are
available as well.
For Rosemount 3301, the PV is typically set to be Level. If the transmitter is in the Immerse
Probe mode, the PV is normally set to Interface Level.
For Rosemount 3302, the PV is typically set to Interface Level, but Level and other options
can also be used.

Upper/lower range value
Set the Lower Range Value (4 mA) and the Upper Range Value (20 mA) to the desired
values. Keep in mind that the 20 mA value must be below the upper transition zone. If the
20 mA point is set to a point within the Transition Zone, the full range of the analog output
is not used.
Make sure the 20 mA value is set below the Upper Null Zone (UNZ). The UNZ parameter
can be used if there are measurement problems in the upper part of the tank. In the
default configuration, the UNZ is equal to zero.
The 4 mA point must be above the lower transition zone. If the 4 mA point is set to a point
within the transition zone or below the probe end (tank bottom for example), the full range
of the analog output is not used.

Figure B-2: Range Values

C

D

E

A

B

F

A. Upper reference point
B. Upper transition zone
C. 20 mA Upper Range Value (URV)
D. Range 0-100 %
E. 4 mA Lower Range Value (LRV)
F. Lower transition zone
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Modbus® setup
If the transmitter has the Modbus option, configuration of the communication parameters
can be set.

Damping value
This parameter defines how fast the transmitter reacts to a change of the level value (step
response). The default value is 10 seconds.
A high value makes the level reading steady, while a low value allows the transmitter to
respond to rapid level changes (but the presented level value may be less steady).

B.2.4  Probe
Probe type
The transmitter is designed to optimize measurement performance for each probe type.
The transmitter automatically makes an initial calibration based on the type of probe that is
used.
This parameter is pre-configured at factory and only needs to be set if the probe is
changed to another type, or if you have installed a spare transmitter.
Select the type of probe that is mounted to the transmitter. Select User Defined probe if
your probe can not be found in the list or if you have done modifications to a standard
probe.
Note
Flexible and rigid probes require different radar electronics and cannot be used with the
same transmitter head.

Probe length
The probe length is the distance between the Upper Reference Point and the end of the
probe. If a weight is used at the end of the probe, it should not be included.
For flexible single lead probes anchored with chuck, the Probe Length should be
configured as the distance from the Upper Reference Point to the top of the chuck.
This parameter is pre-configured at factory. The probe length must be changed if the
probe is shortened, or if you have ordered a spare transmitter head.

Upper null zone
The Upper Null Zone defines how close to the device's Upper Reference Point a level value
is accepted. You can extend Upper Null Zone to block out disturbing echoes close to the
tank top, caused by for example a narrow nozzle with rough walls, obstacles close to the
probe, or a nozzle that protrudes into the tank.
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Figure B-3: Upper Null Zone Is Extended to Block Out Disturbances at the Top of the
Tank

A. Amplitude
B. Distance
C. Upper Null Zone
D. Disturbance
E. Product Surface Peak

Note
Measurements are not performed within the Upper Null Zone.

Related information
Plot the measurement signal
Change the upper null zone

Probe angle (only applicable to rigid probes)
Defines the angle compared to the plumb line at which the device with probe is mounted (0
means that probe is mounted vertically).
Enter the angle between the probe and the vertical line. Do not change this value if the
transmitter is mounted with the probe along the vertical line (which is normally the case).
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Figure B-4: Probe Angle (α)

α

Remote housing
If the transmitter head is mounted apart from the probe, the length of cable between
probe and remote housing must be configured.

B.2.5  Geometry
Tank geometry
The basic transmitter configuration includes setting the tank geometry parameters.
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Figure B-5: Tank Geometry

A

H

I

F

E

G

B

C

D

A. Upper reference point
B. Upper Null Zone (UNZ)
C. Product level
D. Interface level
E. Lower reference point
F. Probe length
G. Reference gauge height
H. 20 mA
I. 4 mA

Upper Reference Point
The Upper Reference Point is located at the underside of the threaded adapter, transmitter
flange, or Tri Clamp®, as illustrated in Figure B-6.
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Figure B-6: Upper Reference Point
A

E

B C D

A. NPT
B. BSPP (G)
C. Flange
D. Tri Clamp
E. Upper Reference Point

Reference gauge height
The Reference Gauge Height is the distance from the upper reference point to the bottom
of the tank. The transmitter measures the distance to the product surface and subtracts
this value from the Reference Gauge Height to determine the level.
The Reference Gauge Height must be set in linear (level) units, such as feet or meters,
regardless of primary variable assignment.

Probe length
The probe length is the distance between the Upper Reference Point and the end of the
probe. If a weight is used at the end of the probe, it should not be included.
For flexible single lead probes anchored with chuck, the Probe Length should be
configured as the distance from the Upper Reference Point to the top of the chuck.
This parameter is pre-configured at factory. The probe length must be changed if the
probe is shortened, or if you have ordered a spare transmitter head.

Mounting type
Select option best describing how device is mounted on the tank.

Nozzle Inner diameter
Select the inner diameter for the pipe, chamber or nozzle in which the probe is mounted.

Nozzle height
The distance between the Upper Reference Point (normally the lower side of the device
flange) and the end of the nozzle. Note that nozzle may extend into the tank (which should
be included in the height).

Measurements below probe end
The Present Level=0... check box controls how the level value is presented when the tank
is almost empty. By selecting this check- box, the Level is set equal to zero as long as the
product surface is below the probe.
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If the check box is not selected, the level value is equal to the difference between reference
gauge height R and probe length L when the product surface is below the probe.

Figure B-7: Measurements Below Probe End

A

B

A. Level = 0
B. Level = R - L

B.2.6  Environment
Measurement mode
Normally, the measurement mode does not need to be changed. The transmitter is pre-
configured according to the specified model:
Table B-1: Measurement Mode
Model Measurement mode
3301 Level(1), interface immersed probe
3302 Level, level and interface(1), interface immersed probe

(1) Default setting.

Interface immersed probe is used for applications where the probe is fully immersed in
liquid. In this mode the transmitter ignores the upper product level.
Note
Use interface immersed probe only for applications where interface is measured for a fully
immersed probe.

Upper product dielectric constant
The Upper Product Dielectric Constant (DC) should be entered as accurately as possible.
The dielectric constant of the upper product is essential for calculating the interface
level and the upper product thickness. In addition, this value is used for setting the
automatically calculated amplitude thresholds. The default value for the Upper Product
Dielectric Constant is 2.
For level measurements, the Upper Product Dielectric Constant parameter corresponds to
the dielectric constant of the product in the tank.
If the dielectric constant of the lower product is significantly smaller than the dielectric
constant of water, you may need to make special adjustments. The dielectric constant of
water is 80.
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Use the dielectric constant chart
The Rosemount Configuration Tool (RCT) software includes a Dielectric Chart which lists the
dielectric constants of a wide range of products.
Procedure

1. Select View → Dielectric → Dielectric Chart.
2. In the Advanced section, click the Dielectric Chart icon.

Dielectric constant calculator
The dielectric calculator in RCT allows you to calculate the dielectric constant of the upper
product based on the following input:
• Actual upper product thickness
• The dielectric constant value stored in the transmitter
• The upper product thickness presented by the transmitter

Vapor dielectric constant
In some applications, there is heavy vapor above the product surface having a significant
influence on the level measurement. In such cases the vapor dielectric can be entered to
compensate for this effect.
The default value is equal to 1, which corresponds to the dielectric constant of vacuum.
Normally this value does not need to be changed since the effect on measurement
performance is very small for most vapors.

Max upper product thickness
Configure the maximum possible thickness for the upper product in this tank. This is the
maximum thickness the device will expect for this tank.

B.2.7  Volume
Tank type
You can choose one of the following options:
• Strap table
• Vertical cylinder
• Horizontal cylinder
• Vertical bullet
• Horizontal bullet
• Sphere
• None

Strapping table
Strapping tables can be used for irregularly shaped tanks, to eliminate errors due to
bulging when product is added to a tank, or if a pre-defined tank type does not provide
sufficient accuracy.
Strapping table requires entering level-volume pairs in a table (maximum 10 points). Use
most of the strapping points in regions where the tank shape is non-linear. Starting at the
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bottom of the tank, for each new point, enter the total volume up to the specified level
value.

Standard tank shapes
Figure B-8: Standard Tank Shapes

A. Diameter
B. Height
C. Vertical cylinder
D. Horizontal cylinder
E. Vertical bullet
F. Horizontal bullet
G. Sphere

Vertical cylinder
Vertical cylinder tanks are specified by diameter and height.
Horizontal cylinder
Horizontal cylinders are specified by diameter and height.
Vertical bullet
Vertical bullet tanks are specified by diameter and height. The volume calculation model
for this tank type assumes that the radius of the bullet end is equal to the diameter/2.
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Horizontal bullet
Horizontal bullets are specified by diameter and height. The volume calculation model for
this tank type assumes that the radius of the bullet end is equal to the diameter/2.
Sphere
Spherical tanks are specified by diameter.

B.2.8  Display
Select which variables to be displayed and the desired language to be used. The display
toggles between the selected variables every two seconds.

B.2.9  Signal Quality Metrics
The Signal Quality Metrics tab contains information about signal quality and surface/noise
margin.
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C  HART® to Modbus® Converter (HMC)
module
The Rosemount 3300 Level Transmitter is a Modbus compatible measurement device
that supports communication with a Remote Terminal Unit (RTU) using a subset of read,
write, and diagnostic commands used by most Modbus compatible host controllers.
The transmitter also supports communication through Levelmaster and Modbus ASCII
protocols.
The HART to Modbus Converter (HMC) module is located inside the Rosemount 3300 Level
Transmitter enclosure and provides power to and communicates with the transmitter
through a HART® interface.

Figure C-1: System Overview

A. Rosemount 3300 enclosure
B. Rosemount 3300 electronics
C. HART signals
D. HART to Modbus Converter
E. Modbus and Levelmaster communication
F. HART signals
G. Remote Terminal Unit
H. RCT/Handheld communicator

During normal operation, the HMC “mirrors” the contents of process variables from the
Rosemount 3300 Level Transmitter to the Modbus registers. To configure the Rosemount
3300 Level Transmitter, it is possible to connect a configuration tool to the HMC.

C.1  Modbus® communication protocol
configuration
The Rosemount 3300 Level Transmitter can communicate with RTUs using Modbus RTU
(often referred to as just “Modbus”), Modbus ASCII, and Levelmaster (also known as “ROS,”
“Siemens,” or “Tank” protocol).
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Table C-1: List of RTU Supported Protocols
RTU Protocols
ABB Totalflow Modbus RTU, Levelmaster
Bristol™ ControlWave™ Micro Modbus RTU
Emerson ROC800 Series Modbus RTU, Levelmaster(1)

Emerson FloBoss™ 107 Modbus RTU, Levelmaster(1)

Kimray® Inc. DACC™ 2000/3000 Levelmaster
ScadaPack Modbus RTU
Thermo Electron Autopilot Modbus RTU, Levelmaster

(1) Levelmaster protocol should be used when using the Emerson Digital Level Sensor (DLS)
User Program or Application Module together with the device. Use Modbus RTU in other
cases.

Modbus ASCII is not commonly used, since it doubles the amount of bytes for the same
message as the Modbus RTU.
If you do not have any of these RTUs, check your RTU manual to see which protocols it
supports.

C.1.1  Modbus® RTU communication setup
The Rosemount 3300 is configured with the default Modbus RTU address 246, and with the
following Modbus RTU communication parameter default settings:
Table C-2: Modbus RTU Communication Parameters
Parameter Default Value Configurable Values
Baud Rate 9600 1200, 2400, 4800, 9600, 19200
Start Bits(1) One One
Data Bits(1) Eight Eight
Parity None None, Odd, Even
Stop Bits One One or Two
Address range 246 1-255

(1) Start Bits and Data Bits cannot be changed.

To reset the communication parameters to default Modbus RTU settings, use the following
Modbus Message:
HMC
Modbus RTU parameter configuration
You want to use address 44 for the Rosemount 3300 Level Transmitter, and the following
communication parameters are used by the host:
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Table C-3: Communication Parameters Used by the Host (Example)
Parameter Value
Baud Rate 4800
Start Bits One
Data Bits Eight
Parity Odd
Stop Bits Two

To configure the Rosemount 3300 Level Transmitter to communicate with the Host in this
example, the following text string is written to the HART Slave 1 message area:
HMC A44 B4800 PO S2.
HMC These three letters are used for safety and will eliminate the risk of changing the

configuration data by mistake.
A44 A indicates that the following number is the new address (address 44). Leading

zeroes are not needed.
B4800 B indicates that the following number is the new baud rate (1200, 2400, 4800,

9600, 19200).
PO P identifies the following letter as parity type (O = odd, E = even, and N = none).
S2 S indicates that the following figure is the number of stop bits (1 = one, 2 = two).

Only values that differ from the current values need to be included. For example, if only
the address is changed, the following text string is written into the 3300 (HART Slave 1)
message area:
HMC A127,
indicates that 127 is the new address.

C.1.2  Levelmaster communication setup
The default and configurable parameter values can be found in Table C-4.
Table C-4: Levelmaster Communication Parameters
Parameter Default value Configurable value
Baud Rate 9600 1200, 2400, 4800, 9600, 19200
Start Bits One One
Data Bits Seven Seven, Eight
Parity None None, Odd, Even
Stop Bits One One or Two
Address 1 1-99

To reset the communication parameters to default Levelmaster settings, use the following
Modbus Message:
HMC M2
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Levelmaster parameter configuration
You want to use address 2 for the Rosemount 3300 Level Transmitter and the host uses the
following parameters:
Table C-5: Levelmaster Communication Parameters
Parameter Value
Baud Rate 9600
Start Bits One
Data Bits Seven
Parity None
Stop Bits One

To configure the Rosemount 3300 Level Transmitter to communicate with the host in this
example, the following text string is written to the Modbus message area:
HMC M2 A2 B9600 D7 PN S1.
Note
Include all the parameters when writing to the message area.
Note that an address must be unique on the bus.
HMC These three letters are used for safety and will eliminate the risk of changing the

configuration data by mistake.
M2 This means that the Levelmaster protocol is to be used.
A2 A indicates that the following is the new address (address 2). Leading zeroes are

not needed.
B9600 B indicates that the following number is the new baud rate (1200, 2400, 4800,

9600, 19200).
D7 D indicates that the following data bits are to be used (7 = seven, 8 = eight).
PN P identifies the following letter as parity type (O = odd, E = even, and N = none).
S1 S indicates that the following figure is the number of stop bits (1 = one, 2 = two).

Note
Start bits are not configurable and cannot be set.

Implemented Levelmaster functions
See Table C-6 for a description of the implemented Levelmaster functions in the HMC.
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Table C-6: Implemented Functions of Levelmaster Protocol
Input format Description Output format
UnnN? Return ID number UnnNnnCcccc
UnnNmm Set ID number UnnNOKCcccc
UnnF? Return number of floats UnnFxCcccc
UnnFx? Set number of floats UnnFOKCcccc
Unn? Return floats and other data UnnDddd.ddFfffEeeeeWwwwCc

ccc(1)

(1) In this case, number of floats is set to 1. If number of floats is set to 2, the Output
Format would be: UnnDddd.ddDddd.ddFfffEeeeeWwwwCcccc

Note
If one float is sent, it is “Float1”. If two floats are sent, it is “Float 1” before “Float 0”.
Table C-7: Letters and Expressions
Letter Description
nn nn is used to identify slave to respond; nn is a number 00-99 or ** (wildcard).

The EmulCtrl Address Holding register can be configured to a higher value than
99. In that case, the address will be truncated to 99.

mm mm is the new ID number for the slave; mm is a number 00-99.
x x is the number of floats returned when slave receives Unn?, x is a number 0-2.
cccc Is the 16 bit CRC checksum, cccc are hexadecimal characters.
ddd.dd ddd.dd is the distance value from slave 1. Note that the first d can also be a ‘-’

(minus).
Float 1 Slave 1 PV.
Float 0 Slave 1 SV.
fff The temperature value. Configured by Holding Register 3208 in HMC.(1)

eeee An error value.
Bit 0: Invalid SV value (Float 0).
Bit 8: Invalid Temperature value.
Bit 12: Invalid PV value (Float 1).

Wwww A warning value, not used in this implementation.

(1) Any of the four available variables from any of the five HART slaves can be selected
as the temperature source. The least four significant bits (bit 0-3) select the variable
number. Bits 4-7 select the HART slave address. If invalid values are used, the
temperature value will be invalid, with no Error bit set. For example, if we want to
use FV from HART Slave 3 as temperature source, we have to write the value 34 Hex (52
decimal).

C.1.3  Modbus ASCII communication setup
The parameter, default, and configurable values are shown in Table C-8.
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Table C-8: Modbus ASCII Communication Parameters
Parameter Default value Configurable values
Baud Rate 9600 1200, 2400, 4800, 9600, 19200
Start Bits One One
Data Bits Seven Seven, Eight
Parity None None, Odd, even
Stop Bits One One or Two
Address 1 1-255

To reset the communication parameters to default Modbus ASCII settings, use the
following Modbus message:
HMC M1
Modbus ASCII parameter configuration
You want to use address 246 for the Rosemount 3300 Level Transmitter and the host uses
the following parameters:
Table C-9: Parameters Used by the Host (In Case of Modbus ASCII, Example)
Parameter Value
Baud Rate 9600
Start Bits One
Data Bits Seven
Parity None
Stop Bits One

To configure the Rosemount 3300 Level Transmitter to communicate with the host in this
example, the following text string is written to the Modbus message area:
HMC M1 A246 B9600 D7 PN S1.
Note
Include all the parameters when writing to the message area.
Note that an address must be unique on the bus.
HMC These three letters are used for safety and will eliminate the risk of changing the

configuration data by mistake.
M1 This means that the Modbus ASCII protocol is to be used.
A246 A indicates that the following number is the new address (address 246). Leading

zeroes are not needed.
B9600 B indicates that the following number is the new baud rate (1200, 2400, 4800,

9600, 19200).
D7 D indicates that the following data bits are to be used (7 = seven, 8 = eight).
PN P identifies the following letter as parity type (O = odd, E = even, and N = none).
S1 S indicates that the following figure is the number of stop bits (1 = one, 2 = two).
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Note
Start bits are not configurable and cannot be set.

C.2  Common Modbus® host configuration
When using Modbus RTU or Modbus ASCII, the registers to receive status and variables
must be configured in the host system.
The transmission of single-precision (4 bytes) IEEE 754 floating point numbers can be
rearranged in different byte orders specified by the Floating Point Format Code. The
format code information, stated for each Remote Terminal Unit (RTU) respectively, specifies
which registers to poll from the Rosemount 3300 Level Transmitter in order for the RTU
to correctly interpret floating point numbers. The byte transmission order for each format
code is demonstrated in Table C-10.
Table C-10: Byte Transmission Order is Specified by the Floating Point Format Code
Format Code Byte transmission order Description
0 [AB] [CD] Straight word order, most

significant byte first
1 [CD] [AB] Inverse word order, most

significant byte first
2 [DC] [BA] Inverse word order, least

significant byte first
3 [BA] [DC] Straight word order, least

significant byte first

Note
Some Modbus hosts cannot read the information described here using Input Registers
(Modbus function code 4). The Input Register information can also be read using Holding
Register (Function code 3). In this case, Input Register number + 5000 is used as Holding
Register number.
Between host system and device, it is recommended to use 60 seconds or less between
polls, and three retries.

C.2.1  Input registers
The register area starting with 1300 can be configured to have any of the four format
codes. The configuration is done by setting FloatingPointFormatCode register (holding
register 3000) to 0-3. This configuration can be done with the Rosemount Radar Master
program.
Note
Depending on the slave number the Rosemount 3300 Level Transmitter is using, different
registers must be used with the default slave number being 1. Slave number is determined
by the HART address.
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Table C-11: Output Variables for the Configurable Floating Point Format (Default Code
1)
Register Name Register Number Note
Slave 1 Status Conf 1300 Bit information in bitfield.

Bit 0: Invalid Measurement Slave 1 PV.
Bit 1: Invalid Measurement Slave 1
Non PV.
Bit 2: Invalid Measurement Slave 1
Non PV.
Bit 3: Invalid Measurement Slave 1
Non PV.
Bit 14: HART bus busy (slave in burst
or other master present)
Bit 15: HTM Task not running (option
not available).
Note
Bit 1-3 is set when Invalid
Measurement of Slave 1 Non PV. i.e.
all three bits are set simultaneously.

Slave 1 PV Conf 1302 Primary variable from slave 1
represented in IEEE 754 format,
using the byte order set in the
FloatingPointFormatCode register.

Slave 1 SV Conf 1304 Secondary variable from slave 1
represented in IEEE 754 format,
using the byte order set in the
FloatingPointFormatCode register.

Slave 1 TV Conf 1306 Tertiary variable from slave 1
represented in IEEE 754 format,
using the byte order set in the
FloatingPointFormatCode register.

Slave 1 FV Conf 1308 Fourth variable from slave 1
represented in IEEE 754 format,
using the byte order set in the
FloatingPointFormatCode register.

Slave 2 data 1310-1318 Same data as for Slave 1.
Slave 3 data 1320-1328 Same data as for Slave 1.
Slave 4 data 1330-1338 Same data as for Slave 1.
Slave 5 data 1340-1348 Same data as for Slave 1.

The Rosemount 3300 Level Transmitter register area starting with register 2000 is used for
hosts that require Floating Point Format Code 0 (see Table C-12).
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Table C-12: Output Variables for Floating Point Format Code 0
Register Name Register Number Note
Slave 1 Status 2000 Bit information in bitfield:

Bit 0: Invalid Measurement
Slave 1 PV.
Bit 1: Invalid Measurement
Slave 1 SV.
Bit 2: Invalid Measurement
Slave 1 TV.
Bit 3: Invalid Measurement
Slave 1 FV.
Bit 14: HART bus busy (slave in
burst or other master present)
Bit 15: HTM Task not running
(option not available).
Note
Bit 1-3 is set when Invalid
Measurement of Slave 1 Non
PV, i.e. all three bits are set
simultaneously.

Slave 1 PV 2002 Primary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 0.

Slave 1 SV 2004 Secondary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 0.

Slave 1 TV 2006 Tertiary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 0.

Slave 1 FV (QV) 2008 Fourth variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 0.

Floating Point Format Codes 2 and 3 use register areas 2100 and 2200, respectively (see
Table C-13 and Table C-14).
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Table C-13: Output Variables for Floating Point Format Code 2
Register Name Register Number Note
Slave 1 Status 2100 Bit information in bitfield:

Bit 0: Invalid Measurement
Slave 1 PV.
Bit 1: Invalid Measurement
Slave 1 SV.
Bit 2: Invalid Measurement
Slave 1 TV.
Bit 3: Invalid Measurement
Slave 1 FV.
Bit 14: HART bus busy (slave in
burst or other master present)
Bit 15: HTM Task not running
(option not available).
Note
Bit 1-3 is set when Invalid
Measurement of Slave 1 Non
PV, i.e. all three bits are set
simultaneously.

Slave 1 PV 2102 Primary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 2.

Slave 1 SV 2104 Secondary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 2.

Slave 1 TV 2106 Tertiary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 2.

Slave 1 FV (QV) 2108 Fourth variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 2.
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Table C-14: Output Variables for Floating Point Format Code 3
Register Name Register Number Note
Slave 1 Status 2200 Bit information in bitfield:

Bit 0: Invalid Measurement
Slave 1 PV.
Bit 1: Invalid Measurement
Slave 1 SV.
Bit 2: Invalid Measurement
Slave 1 TV.
Bit 3: Invalid Measurement
Slave 1 FV.
Bit 14: HART bus busy (slave in
burst or other master present)
Bit 15: HTM Task not running
(option not available).
Note
Bit 1-3 is set when Invalid
Measurement of Slave 1 Non
PV, i.e. all three bits are set
simultaneously.

Slave 1 PV 2202 Primary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 3.

Slave 1 SV 2204 Secondary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 3.

Slave 1 TV 2206 Tertiary variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 3.

Slave 1 FV (QV) 2208 Fourth variable from slave 1
represented in IEEE 754 format,
using Floating Point Format
Code 3.

C.2.2  Measurement units
Measurement units for the various HART slaves are stored in input registers as a Unit Code
presented in Table C-15.
Table C-15: Measurement Units and Corresponding Input Registers
Register Name Register Number
Slave 1 PV Units 104
Slave 1 SV Units 108
Slave 1 TV Units 112
Slave 1 FV (QV) Units 116

Conversion from Unit Code to measurement unit is given in Table C-16.
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Table C-16: Conversion of Unit Code to Measurement Unit
Measurement Unit Code Measurement Unit

Volume

40 US Gallon
41 Liters
42 Imperial Gallons
43 Cubic Meters
46 Barrels
111 Cubic Yards
112 Cubic Feet
113 Cubic Inches

Length

44 Feet
45 Meters
47 Inches
48 Centimeters
49 Millimeters

Temperature
33 Degree Fahrenheit
32 Degree Celsius

C.3  Specific Modbus® host configuration
The Remote Terminal Unit needs to be configured to communicate and correctly interpret
data when reading input registers from the Rosemount 3300 Level Transmitter.
Baud rate
The specified Baud Rates are recommendations. If other Baud Rates are used, make
sure the Rosemount 3300 Level Transmitter and the RTU are configured for the same
communication speed.
Floating point format code
See Common Modbus® host configuration.
RTU data type
The RTU data type specifies which configuration to use in the RTU in order for the RTU
to correctly interpret a floating point number transmitted from the Rosemount 3300 Level
Transmitter with Modbus.
Input register base number
Data registers in the Rosemount 3300 Level Transmitter with Modbus are numbered
exactly as they are transmitted in the Modbus communication. Some RTUs use different
naming conventions and to configure the RTU to poll the correct registers from the
Rosemount 3300 Level Transmitter Modbus, an Input Register Base Number is stated for
each RTU respectively. For example, if the input register base number is 1 for the RTU, the
Rosemount 3300 Level Transmitter Modbus input register 1302 has to be entered in the
RTU address as input register 1303.
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C.3.1  Emerson ROC800 Series
Figure C-2: Wiring Diagram for Connecting Rosemount 3300 Modbus to Emerson
ROC800 Series
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A. Rosemount 3300 Modbus
B. Power supply
C. + 8 to + 30 Vdc (max. rating)
D. ROC800 Series

Table C-17: Parameter Values (In Case of Emerson ROC800 Series)
Parameter Value
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type Conversion Code 66
Input Register Base Number 0

The Input Register Base Number needs to be added to the Input Register address of the
Rosemount 3300 Level Transmitter. In this case, register 1300 needs to have 1300 entered
as the address.
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C.3.2  Emerson FloBoss 107
Figure C-3: Wiring Diagram for Connecting Rosemount 3300 Modbus to Emerson
FloBoss 107
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Table C-18: Parameter Values (In Case of Emerson FloBoss 107)
Parameter Value
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type Conversion Code 66
Input Register Base Number 0

The Input Register Base Number needs to be added to the Input Register address of the
Rosemount 3300 Level Transmitter. In this case, register 1300 needs to have 1300 entered
as the address.
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C.3.3  ABB TotalFlow
Figure C-4: Wiring Diagram for Connecting Rosemount 3300 Modbus to ABB TotalFlow
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Table C-19: Parameter Values (In Case of ABB TotalFlow)
Parameter Value
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type 16 Bit Modicon
Input Register Base Number 1

The Input Register Base Number needs to be added to the Input Register address of the
Rosemount 3300 Level Transmitter. In this case, register 1302 needs to have 1303 entered
as the address etc.
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C.3.4  Thermo Electron Autopilot
Figure C-5: Wiring Diagram for Connecting Rosemount 3300 Modbus to Thermo
Electron Autopilot
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Table C-20: Parameter Values (In Case of Thermo Electron Autopilot)
Parameter Value
Baud Rate 9600
Floating Point Format Code 1
RTU Data Type IEEE Flt 2R
Input Register Base Number 0

The Input Register Base Number needs to be added to the Input Register address of the
Rosemount 3300 Level Transmitter. In this case, register 1302 needs to have 1302 entered
as the address etc.

Reference Manual HART® to Modbus® Converter (HMC) module
00809-0100-4811 June 2023

Rosemount 3300 Level Transmitter 193



C.3.5  Bristol ControlWave Micro
Figure C-6: Wiring Diagram for Connecting Rosemount 3300 Modbus to Bristol
ControlWave Micro
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Table C-21: Parameter Values (In Case of Bristol ControlWave Micro)
Parameter Value
Baud Rate 9600
Floating Point Format Code 2 (FC 4)
RTU Data Type 32-bit registers as 2 16-bit registers
Input Register Base Number 1

The Input Register Base Number needs to be added to the Input Register address of the
Rosemount 3300 Level Transmitter. In this case, register 1302 needs to have 1303 entered
as the address etc.
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C.3.6  ScadaPack
Figure C-7: Wiring Diagram for Connecting Rosemount 3300 Modbus to SCADAPack 32
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A. Rosemount 3300 Modbus
B. Power supply
C. + 8 to + 30 Vdc (max. rating)
D. SCADAPack32

Table C-22: Parameter Values (In Case of SCADAPack 32)
Parameter Value
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type Floating Point
Input Register Base Number 30001

The Input Register Base Number needs to be added to the Input Register address of the
Rosemount 3300 Level Transmitter. In this case, register 1302 needs to have 31303 entered
as the address etc.

C.3.7  Kimray Inc. DACC 2000/3000
Table C-23 shows input types in Kimray Inc. IMI software and the corresponding value. The
communication port must be configured to use “Tank Levels” protocol.
Table C-23: Kimray Inc. Input Types and Corresponding Values
Kimray Inc. Input Type Rosemount 3300 Variable Format
Tank Level1 PV ddd.dd.alt. -dd.dd
Tank Level2 SV ddd.dd.alt -dd.dd

Reference Manual HART® to Modbus® Converter (HMC) module
00809-0100-4811 June 2023

Rosemount 3300 Level Transmitter 195



00809-0100-4811
Rev. DC

2023

For more information: Emerson.com
©2023 Emerson. All rights reserved.
Emerson Terms and Conditions of Sale are available
upon request. The Emerson logo is a trademark and
service mark of Emerson Electric Co. Rosemount is a
mark of one of the Emerson family of companies. All
other marks are the property of their respective owners.

http://Emerson.com

	Rosemount 3300 Level Transmitter
	Contents
	1 Introduction
	1.1 Using this manual
	1.2 Product certifications
	1.3 Product recycling/disposal

	2 Transmitter overview
	2.1 Measurement principle
	2.2 Application examples
	2.3 System architecture
	2.4 Components of the transmitter
	2.5 Process characteristics
	2.5.1 Contamination/product build-up
	2.5.2 Bridging
	2.5.3 Foam
	2.5.4 Vapor
	2.5.5 Interface measurements

	2.6 Vessel characteristics
	2.6.1 Heating coils, agitators
	2.6.2 Tank shape

	2.7 Probe selection guide

	3 Mechanical installation
	3.1 Safety messages
	3.2 Installation procedure
	3.2.1 Workflow for commissioning a transmitter with Modbus® protocol

	3.3 Before you install
	3.3.1 Equipment category
	3.3.2 Alarm and write protection switches
	3.3.3 Set jumpers and switches
	Set alarm and write protection on the circuit board
	Set alarm and write protection on the LCD display


	3.4 Installation and mounting considerations
	3.4.1 Recommended mounting position for liquids
	3.4.2 Free space requirement
	3.4.3 Flange connection on nozzles
	Narrow nozzles

	3.4.4 Installation in still pipe/chamber
	General chamber considerations
	Rosemount chamber
	Existing chamber
	Probe type in chamber considerations
	Centering disc for pipe installations

	3.4.5 Installation in non-metallic tanks and open-air applications
	3.4.6 Minimum distance between two single probes
	3.4.7 Insulated tanks

	3.5 Shorten the probe
	3.5.1 Shorten the flexible single/twin lead probe
	3.5.2 Shorten the rigid single lead probe
	3.5.3 Shorten the rigid twin lead probe
	3.5.4 Shorten the coaxial probe

	3.6 Mount a centering disc
	3.6.1 Mount a centering disc on flexible single/twin lead probe
	3.6.2 Mount a centering disc on rigid single lead probe (8 mm)
	3.6.3 Mount a centering disc on rigid single lead probe (13 mm)

	3.7 Mount device on tank
	3.7.1 Tank connection with flange
	3.7.2 Tank connection with loose flange (plate design)
	3.7.3 Threaded tank connection
	3.7.4 Bracket mounting
	3.7.5 Tank connection with Tri Clamp
	3.7.6 Segmented probe
	Segmented probe parts
	Verifying probe length
	Adjust the probe length
	Determination of probe segments
	Assemble the segmented probe


	3.8 Anchor the probe

	4 Electrical installation
	4.1 Safety messages
	4.2 Power supply
	4.3 Cable selection
	4.4 Cable/conduit entries
	4.5 Wiring diagram
	4.6 Load limitations
	4.7 HART® to Modbus® converter (HMC)
	4.7.1 Signal wiring
	4.7.2 Power supply cabling
	4.7.3 Ground (common mode) voltage limit
	4.7.4 Bus termination
	4.7.5 Connection terminals
	4.7.6 RS-485 bus
	4.7.7 Installation cases
	Star topology


	4.8 Connect the transmitter
	4.9 Optional devices
	4.9.1 Rosemount™ 333 HART® Tri-Loop™
	4.9.2 Rosemount 751 Field Signal Indicator


	5 Configuration
	5.1 Safety messages
	5.2 Overview
	5.3 Establish HART® communication for transmitter with HART to Modbus® Converter
	5.3.1 Connect to the MA/MB terminals
	5.3.2 Connect to the HART terminals

	5.4 Configuration using the Radar Configuration Tool
	5.4.1 Installing the Radar Configuration Tools (RCT) software
	5.4.2 Starting RCT
	5.4.3 Specify the COM port
	5.4.4 Configuration using the Wizard
	5.4.5 Configuration using the Setup Function
	Setup - Basics
	Setup - Output
	Setup - Tank Config

	5.4.6 Additional configuration to fine-tune performance

	5.5 Change Modbus communication parameters
	5.5.1 Change Modbus communication parameters using RCT
	5.5.2 Change Modbus communication parameters using a handheld communicator

	5.6 Configure the alarm output for the Modbus® transmitter
	5.6.1 Modbus alarm output strings
	5.6.2 Verify alarm output
	5.6.3 Use status information to evaluate measurement validity
	5.6.4 Use Heartbeat to detect errors

	5.7 Advanced configuration
	5.7.1 Set user defined upper reference point

	5.8 HART® multi-drop configuration
	5.8.1 Change the poll address

	5.9 Use with the Rosemount 333 HART® Tri-Loop™
	5.9.1 Set the COM port buffers in Windows XP
	5.9.2 Set the COM port buffers in Windows 7, 8, or 8.1


	6 Operation
	6.1 Display functionality
	6.1.1 Variable screens

	6.2 Error messages

	7 Service and troubleshooting
	7.1 Safety messages
	7.2 Diagnostic messages
	7.2.1 View diagnostic messages
	7.2.2 Errors
	Invalid configuration
	RAM failure
	FPROM failure
	Waveform acquisition failure
	EEPROM factory checksum
	EEprom user checksum error
	Software error
	Probe failure

	7.2.3 Warnings
	Reference peak not found
	No level peak is found
	Interface peak not found
	Internal temperature out of range
	Volume computation warning
	Immersed probe


	7.3 Troubleshooting guides
	7.3.1 Troubleshooting incorrect level readings
	Interface Level is reported as Not A Number (NAN)
	Level and interface level are reported as NAN
	Interface level is equal to the product Level
	Level is incorrectly reported as full or empty
	Reference peak is not detected
	Level accuracy seems off

	7.3.2 There is no HART communication (lost device communication)
	7.3.3 Troubleshooting the HART® to Modbus® Converter
	No communication on RS-485 bus (MA, MB)
	No communication in RCT using HART+, HART-
	No communication in RCT using MA, MB
	No communication with Modbus RTU protocol
	No communication with Modbus ASCII protocol
	No communication with Levelmaster protocol

	7.3.4 Analog out is set in alarm
	7.3.5 Integral display does not work

	7.4 Service and troubleshooting tools
	7.4.1 Waveform plot function
	Echo peaks
	Amplitude thresholds
	Plot the measurement signal
	Log and save the waveform plot to disk

	7.4.2 Amplitude thresholds
	Guidelines for setting the amplitude thresholds
	Adjust the amplitude thresholds
	Example 1: Product surface peak not found
	Example 2: Interface peak not found

	7.4.3 Calibrate analog output
	7.4.4 Calibrate distance and level
	Calibrate distance
	Calibrate level

	7.4.5 Logging measurement data
	Save the log to disk
	Counter

	7.4.6 Saving the transmitter configuration
	Save the current transmitter setup
	Memory map
	Save configuration data in the memory map window

	7.4.7 Load a setup
	7.4.8 Upgrade the HART® to Modbus® Converter firmware

	7.5 Application challenges
	7.5.1 Handling disturbances at top of tank
	Trim Near Zone function
	Perform trim near zone
	Reset trim near zone

	Change the upper null zone

	7.5.2 Interface level with submerged probe
	Set the measurement mode


	7.6 Replace the transmitter head
	7.7 Replace the probe
	7.8 Service support

	A Specifications and reference data
	A.1 Performance specifications
	A.1.1 General
	Reference conditions
	Reference accuracy
	Repeatability
	Ambient temperature effect
	Update interval

	A.1.2 Environment
	Vibration resistance
	Electromagnetic compatibility
	CE-mark
	Built-in lightning protection
	Contamination/product build-up

	A.1.3 Measuring range
	Measuring range and minimum dielectric constant
	Interface measuring range
	Transition zones


	A.2 Functional specifications
	A.2.1 General
	Field of application
	Measurement principle
	Microwave output power
	EMC
	Humidity
	Start-up time

	A.2.2 4-20 mA HART®
	Output
	Emerson Wireless 775 THUM™ Adapter
	Power requirements
	Signal on alarm
	Saturation levels
	Load limitations

	A.2.3 Modbus®
	Output
	External power supply
	Power consumption

	A.2.4 Display and configuration
	Integral display
	Remote display
	Configuration tools
	Output units
	Output variables
	Damping

	A.2.5 Process temperature and pressure rating
	A.2.6 Temperature limits
	A.2.7 Flange rating
	A.2.8 Tri Clamp rating
	A.2.9 Plate design
	A.2.10 Conditions used for flange strength calculations
	A.2.11 Interface measurements
	Interface measurement considerations
	Emulsion layers


	A.3 Physical specifications
	A.3.1 Material selection
	A.3.2 Engineered solutions
	A.3.3 Housing and enclosure
	A.3.4 Remote housing mounting
	A.3.5 Tank connection
	A.3.6 Flange dimensions
	A.3.7 Vented flanges
	A.3.8 Tri Clamp connection
	A.3.9 Pressure Equipment Directive (PED)
	A.3.10 Probes
	Probe versions
	Total probe length
	Cut-to-fit probes
	Minimum and maximum probe length
	Probe angle
	Tensile strength
	Collapse load
	Sideway capacity

	A.3.11 Material exposed to tank atmosphere
	A.3.12 Weight
	A.3.13 End weight options

	A.4 Dimensional drawings
	A.4.1 Standard flanges
	A.4.2 Proprietary flanges
	A.4.3 Flushing connection rings


	B Configuration parameters
	B.1 Menu tree
	B.2 Setup
	B.2.1 Info
	Device name
	EPROM ID
	Device type
	Device ID
	Hardware rev
	Software rev

	B.2.2 Basics
	Variable units
	Tag
	Descriptor
	Message

	B.2.3 Output
	Transmitter variables
	Upper/lower range value
	Modbus® setup
	Damping value

	B.2.4 Probe
	Probe type
	Probe length
	Upper null zone
	Probe angle (only applicable to rigid probes)
	Remote housing

	B.2.5 Geometry
	Tank geometry
	Upper Reference Point
	Reference gauge height
	Probe length
	Mounting type
	Nozzle Inner diameter
	Nozzle height
	Measurements below probe end

	B.2.6 Environment
	Measurement mode
	Upper product dielectric constant
	Use the dielectric constant chart
	Dielectric constant calculator

	Vapor dielectric constant
	Max upper product thickness

	B.2.7 Volume
	Tank type
	Strapping table
	Standard tank shapes

	B.2.8 Display
	B.2.9 Signal Quality Metrics


	C HART® to Modbus® Converter (HMC) module
	C.1 Modbus® communication protocol configuration
	C.1.1 Modbus® RTU communication setup
	C.1.2 Levelmaster communication setup
	Implemented Levelmaster functions

	C.1.3 Modbus ASCII communication setup

	C.2 Common Modbus® host configuration
	C.2.1 Input registers
	C.2.2 Measurement units

	C.3 Specific Modbus® host configuration
	C.3.1 Emerson ROC800 Series
	C.3.2 Emerson FloBoss 107
	C.3.3 ABB TotalFlow
	C.3.4 Thermo Electron Autopilot
	C.3.5 Bristol ControlWave Micro
	C.3.6 ScadaPack
	C.3.7 Kimray Inc. DACC 2000/3000




